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Rosemount 3300 Series Guided Wave Radar Level and Interface Transmitters may be protected by one or 
more of the following U.S. Patent Nos. 5,955,684; 6,148,681; 6,198,424; 6,373,261 and other patents issued or 
pending in the U.S. and other countries. May depend on model.
Rosemount and the Rosemount logotype are registered trademarks of Rosemount Inc.
HART is a registered trademark of the HART Communication Foundation.
Teflon, VITON, and Kalrez are registered trademarks of DuPont Performance Elastomers.
Asset Management Solutions is a trademark of Emerson Process Management.
Cover Photo: CoverPhoto_08/CoverPhoto_07

NOTICE

Read this manual before working with the product. For personal and system safety, and for 
optimum product performance, make sure you thoroughly understand the contents before 
installing, using, or maintaining this product.

Within the United States, Rosemount Inc. has two toll-free assistance numbers.

Customer Central: 1-800-999-9307(7:00 a.m. to 7:00 p.m. CST)
Technical support, quoting, and order-related questions.

North American Response Center:
Equipment service needs.

1-800-654-7768 (24 hours a day – Includes Canada) 

For equipment service or support needs outside the United States, contact your local 
Rosemount representative.

The products described in this document are NOT designed for nuclear-qualified 
applications. 

Using non-nuclear qualified products in applications that require nuclear-qualified hardware 
or products may cause inaccurate readings. 

For information on Rosemount nuclear-qualified products, contact your local Rosemount 
Sales Representative.

This product is designed to meet FCC and R&TTE requirements for a non-intentional 
radiator. It does not require any licensing whatsoever and has no tank restrictions 
associated with telecommunications issues.

This device complies with part 15 of the FCC rules. Operation is subject to the following two 
conditions: (1) This device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesired 
operation.
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Section 1 Introduction
Safety Messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 1-1
Manual Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 1-2
Service Support  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 1-3

SAFETY MESSAGES Procedures and instructions in this manual may require special precautions to 
ensure the safety of the personnel performing the operations. Information that 
raises potential safety issues is indicated by a warning symbol ( ). Refer to 
the safety messages listed at the beginning of each section before performing 
an operation preceded by this symbol. 

Failure to follow these installation guidelines could result in death or serious 
injury.

• Make sure only qualified personnel perform the installation.

• Use the equipment only as specified in this manual. Failure to do so may 
impair the protection provided by the equipment.

Explosions could result in death or serious injury.
• Verify that the operating environment of the transmitter is consistent with the 

appropriate hazardous locations certifications.

• Before connecting a HART®-based communicator in an explosive atmosphere, 
make sure the instruments in the loop are installed in accordance with 
intrinsically safe or non-incendive field wiring practices.

Electrical shock could cause death or serious injury.
• Use extreme caution when making contact with the leads and terminals.

Any substitution of non-recognized parts may jeopardize safety. Repair, e.g. substitution 
of components etc., may also jeopardize safety and is under no circumstances allowed.
www.rosemount.com
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MANUAL OVERVIEW This manual provides installation, configuration and maintenance information 
for the Rosemount 3300 Series Radar Transmitter.

Section 2: Transmitter Overview
• Theory of Operation
• Description of the transmitter
• Process and vessel characteristics

Section 3: Installation
• Mounting considerations
• Mechanical installation
• Electrical installation

Section 4: Start-Up
• Configuration instructions
• Configuration using the HART Communicator
• Configuration using the RCT software

Section 5: Operating the Display Panel
• Display functionality
• Error messages

Section 6: Service and Troubleshooting
• Advanced Configuration
• Error and Warning Codes
• Communication Errors

Appendix A: Reference Data
• Specifications
• Ordering Information

Appendix B: Product Certifications
• Examples of labels
• European ATEX Directive information
• FM approvals
• CSA approvals
• Drawings
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SERVICE SUPPORT To expedite the return process outside of the United States, contact the 
nearest Rosemount representative.

Within the United States, call the Rosemount National Response Center using 
the 1-800-654-RSMT (7768) toll-free number. This center, available 24 hours 
a day, will assist you with any needed information or materials.

The center will ask for product model and serial numbers, and will provide a 
Return Material Authorization (RMA) number. The center will also ask for the 
process material to which the product was last exposed.

Rosemount National Response Center representatives will explain the 
additional information and procedures necessary to return goods exposed to 
hazardous substance can avoid injury if they are informed of and understand 
the hazard. If the product being returned was exposed to a hazardous 
substance as defined by OSHA, a copy of the required Material Safety Data 
Sheet (MSDS) for each hazardous substance identified must be included with 
the returned goods.
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Section 2 Transmitter Overview
Theory of Operation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 2-1
Applications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 2-2
Components of the Transmitter  . . . . . . . . . . . . . . . . . . . . page 2-4
System Architecture . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 2-5
Probe Selection Guide . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 2-6
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THEORY OF OPERATION The Rosemount 3300 Series Radar Transmitter is a smart, two-wire 
continuous level transmitter that is based on Time Domain Reflectometry 
(TDR) principles. Low power nano-second-pulses are guided along a probe 
immersed in the process media. When a pulse reaches the surface of the 
material it is measuring, part of the energy is reflected back to the transmitter, 
and the time difference between the generated and reflected pulse is 
converted into a distance from which the total level or interface level is 
calculated (see below). 

The reflectivity of the product is a key parameter for measurement 
performance. A high dielectric constant of the media gives better reflection 
and a longer measuring range. A calm surface gives better reflection than a 
turbulent surface.

Figure 2-1. Measurement 
Principle.
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APPLICATIONS The Rosemount 3300 Series Radar Transmitter program is suited for 
aggregate (total) level measurements on most liquids, semi-liquids, and 
liquid/liquid interfaces. 

Guided microwave technology offers highest reliability and precision which 
ensure measurements are virtually unaffected by temperature, pressure, 
vapor gas mixtures, density, turbulence, bubbling/boiling, low level, varying 
dielectric media, pH, and viscosity.

Guided wave radar technology in combination with advanced signal 
processing make the 3300 transmitters suitable for a wide range of 
applications:

Figure 2-2. Application 
examples

Boiling conditions with 
vapor and turbulence. For 
these applications the 
Coaxial probe is particularly 
suitable.

The Rosemount 3300 
Series of transmitters is well 
suited for bridle applications 
such as distillation columns.
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Separator tank. The 
Rosemount 3302 measures 
both level and interface 
level.

The Rosemount 3300 
series is a good choice for 
underground tanks since it 
is installed on the tank top 
with the radar pulse 
concentrated near the 
probe. It can be equipped 
with probes that are 
unaffected by high and 
narrow openings or nearby 
objects.

Guided wave radar 
technology is a good choice 
for reliable measurements 
in small ammonia, NGL and 
LPG tanks.
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COMPONENTS OF THE 
TRANSMITTER

The Rosemount 3300 Series Radar Transmitter has an aluminum transmitter 
housing which contains advanced electronics for signal processing. 

The radar electronics produces an electromagnetic pulse which is guided by 
the probe. 

There are different probe types available for various applications: Rigid Twin 
Lead, Flexible Twin Lead, Rigid Single Lead, Flexible Single Lead, and 
Coaxial. 

Figure 2-3. Transmitter 
components.

NOTE
Flexible and Rigid probes require different radar electronics and can not be 
used with the same transmitter head.

Radar Electronics

Probe

Dual Compartment Housing

Cable Entry:
½" NPT.
Optional adapters:
M20, PG13.5 Threaded Process 

Connections
Flanged Process 
Connections

BSP (G)

NPT

Coaxial

Flexible Twin Lead with weight

Rigid Twin Lead
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SYSTEM 
ARCHITECTURE

The Rosemount 3300 Series Radar Transmitter is loop-powered which 
means it uses the same two wires for both power supply and output signal. 
The output is a 4-20 mA analog signal superimposed with a digital HART 
signal.

By using the optional HART Tri-loop, it is possible to convert the HART signal 
to up to three additional 4-20 mA analog signals.

With the HART protocol it is possible to use multidrop configuration. In this 
case communication is restricted to digital since current is fixed to the 4 mA 
minimum value. 

The transmitter can be connected to display Rosemount 751 Field Signal 
Indicator or it can be equipped with an integral display.

The transmitter can easily be configured by using a Field Communicator or a 
PC with the Radar Configuration Tool software. Rosemount 3300 Series 
transmitters are also compatible with the AMS Suite software which also can 
be used for configuration.

For HART communication a minimum load resistance of 250 Ohm within the 
loop is required.

Figure 2-4. System architecture.

 

4-20 mA/HART

Rosemount 751 
Field Signal Indicator

Field 
Communicator

HART modem

3300 SERIES 
RADAR 

TRANSMITTER

DCS

Tri-Loop

3 x 4-20 mA

Radar Configuration Tool
or
AMS Suite

Integral 
Display

S
YS

TE
M

_C
ANote! For HART communication a 

minimum load resistance of 
250 Ohm within the loop is required.
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PROBE SELECTION 
GUIDE

Use the following guidelines to choose appropriate probe for your 3300 
transmitter:

Table 2-1.  Probe selection guide. G=Good, NR=Not Recommended, AD=Application Dependent (consult factory)

Coaxial Rigid Twin Lead Flexible Twin Lead Rigid Single Lead Flexible Single Lead
Measurements

Level G G G G G
Interface (liquid/liquid) G(1) G G NR NR

Process Medium Characteristics
Changing density G G G G G
Changing dielectric(2) G G G G G
Wide pH variations G G G G G
Pressure changes G G G G G
Temperature changes G G G G G
Condensing vapors G G G G G
Bubbling/boiling surfaces G G AD G AD
Foam (mechanical 
avoidance) AD NR NR NR NR

Foam (top of foam 
measurement) NR AD AD AD AD

Foam (foam and liquid 
measurement) NR AD AD NR NR

Clean liquids G G G G G
Liquid with dielectric<2.5 G AD AD AD(3) NR
Coating liquids NR NR NR AD AD
Viscous liquids NR AD AD AD G
Crystallizing liquids NR NR NR AD AD
Solids/Powders NR NR NR AD AD
Fibrous liquids NR NR NR G G

Tank Environment Considerations
Probe is close 
(<12 in./30 cm) to tank wall 
/ disturbing objects

G AD AD NR NR

High turbulence G G AD G AD
Turbulent conditions 
causing breaking forces NR NR AD NR AD

Long and small mounting 
nozzles
(diameter <6 in./15 cm,
height>diameter + 4 in./10 
cm)

G AD NR NR NR

Probe might touch nozzle / 
disturbing object G NR NR NR NR

Liquid or vapor spray might 
touch probe G NR NR NR NR

Disturbing EMC 
environment in tank AD NR NR NR NR

(1) Not in fully immersed applications.
(2) For overall level applications a changing dielectric has no effect on the measurement. For interface measurements a changing dielectric of the top fluid 

will degrade the accuracy of the interface measurement.
(3) OK when installed in pipe.
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Dead Zones The measuring range depends on probe type and properties of the product. 
The Upper Dead Zone is the minimum measurement distance between the 
upper reference point and the product surface. The Upper Dead Zone varies 
between 4 - 20 in. (0.1 and 0.5 m) depending on probe type and product.

At the end of the probe the measuring range is reduced by the Lower Dead 
Zone. The Lower Dead Zone also varies depending on probe type and 
product. 

Figure 2-5 illustrates how the measuring range is related to the Dead Zones:

Figure 2-5. Dead Zones

NOTE
The measurement accuracy is reduced in the Dead Zones. It may even be 
impossible to make any measurements at all in those regions. Therefore the 
4-20 mA set points should be configured outside the Dead Zones.

4mA

20mA

Upper Dead Zone

Lower Dead Zone

R
an

ge
 0

 -1
00

 %

Maximum 
Measuring Range

Upper Reference Point

D
E

AD
 Z

O
N

ES

Table 2-2.  Dead Zones for different probe types
Dielectric 
Constant

Coaxial Probe Rigid Twin 
Lead Probe

Flexible Twin 
Lead Probe

Rigid Single 
Lead Probe

Flexible Single 
Lead Probe

Upper 
Dead Zone

2 4 in. (10 cm) 4 in. (10 cm) 8 in. (20 cm) 4 in. (10 cm) 20 in. (50 cm)
80 4 in. (10 cm) 4 in. (10 cm) 5.9 in. (15 cm) 4 in. (10 cm) 5.9 in. (15 cm)

Lower 
Dead Zone

2 2 in. (5 cm) 2.8 in. (7 cm) 5.9 in. (15 cm) 4 in. (10 cm)(1) 4.7 in. (12 cm)
80 1.2 in. (3 cm) 2 in. (5 cm) 2 in. (5 cm) 2 in. (5 cm) 2 in. (5 cm)

(1) Dead Zone=8 inch (20 cm) when SST centering disc is mounted. The PTFE centering disc does not affect the Dead Zone.
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PROCESS 
CHARACTERISTICS

The Rosemount 3300 Series has a high sensitivity due to its advanced signal 
processing and high signal to noise ratio, which makes it able to handle 
various disturbances. However, the following circumstances should be 
considered before mounting the transmitter.

Coating Coating on the probe should be avoided since the sensitivity of the transmitter 
may be decreased leading to measurement errors. In viscous or sticky 
applications, periodic cleaning may be required. 

For viscous or sticky applications, it is important to choose a suitable probe:

Table 2-3.  Probe type guide for 
different product viscosity

Maximum measurement error due to coating is 1-10% depending on probe 
type, dielectric constant, coating thickness and coating height above product 
surface.

Bridging Heavy coating that results in product bridging across the two probes for twin 
lead versions, or between the pipe and the inner rod for coaxial probes, will 
cause erroneous level readings and must be prevented. Single lead probes 
are preferred in this case. If a Twin Lead probe is required, regular cleaning 
may be necessary.

Foam How well the Rosemount 3300 Series Radar Transmitter measures in foamy 
applications depends upon the properties of the foam; light and airy or dense 
and heavy, high or low dielectrics, etc. If the foam is conductive and creamy 
the transmitter will probably measure the surface of the foam. If the foam is 
less conductive the microwaves will probably penetrate the foam and 
measure the liquid surface.

Vapor In some applications, as ammonia, there is heavy vapor above the product 
surface that will influence the level measurement. The Rosemount 3300 
Series Radar Transmitter can be configured to compensate for the influence 
of vapor.

Coaxial Twin Lead Single Lead
Maximum viscosity

500 cP 1500 cP 8000 cP(1)(2)

(1) Consult factory if agitation/turbulence and high viscous products.
(2) HTHP and HP single probes should be used with precaution in viscous or crystallizing media. Cooling 

of high temperature vapor in the upper part of the probe may lead to condensation and deposition 
that blocks the measurement signal.

Coating/Build-up
Coating not recommended Thin coating allowed, but no 

bridging
Coating allowed
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Measuring Range The measuring range differs depending on probe type and characteristics of 
the application. The values given in Table 2-4 can be used as a guideline for 
clean liquids.

Table 2-4.  Measuring Range

The maximum measuring range differs depending on application according 
to:

• Disturbing objects close to the probe.
• Media with higher dielectric constant (εr) gives better reflection and 

allows a longer measuring range.
• A calm surface gives better reflection than a turbulent surface. For a 

turbulent surface the measuring range might be reduced.
• Surface foam and particles in the tank atmosphere are also 

circumstances that might affect measuring performance.
• Coating/contamination can reduce the measuring range. 
• Disturbing EMC environment in tank.

Interface Rosemount 3302 is the ideal choice for measuring the interface of oil and 
water, or other liquids with significant dielectric differences. It is also possible 
to measure interface with a Rosemount 3301 in applications where the probe 
is fully immersed in the liquid.

Figure 2-6. Interface 
measurement with a Rosemount 
3302 and a Rosemount 3301 
(fully immersed probe).

Coaxial, Rigid twin, Flexible twin and Rigid Single lead probes can be used for 
measuring interfaces. The coaxial probe is the preferred choice for clean 
liquids and when the bridle is not fully immersed. In applications with a fully 
immersed probe, the twin lead probes are recommended for nozzle 
installations, and the rigid single lead probe is best for bridle mounting.

Coaxial Rigid Twin Lead Flexible Twin Lead Rigid Single Lead Flexible Single Lead
Maximum Measuring Range

19 ft 8 in. (6 m) 9 ft 10 in. (3 m) 77 ft 1in. (23.5 m) 9 ft 10 in. (3 m) 77 ft 1in. (23.5 m)
Minimum Dielectric Constant at Maximum Measuring Range

Standard & HP:
1.4
HTHP:
2.0 up to 13 ft (4 m) 
2.5 up to 19 ft 8 in. (6 m)

1.9 1.6 up to 33 ft (10 m)
2.0 up to 66 ft (20 m)
2.4 up to 77 ft 1 in. (23.5 m)

2.5 
(1.7 if installed in a 
metallic bypass or stilling 
well)

2.5 up to 36.1 ft (11 m)
5.0 up to 66 f (20 m)
7.5 up to 77 ft 1 in. (23.5 m)
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ALevel

3302 3301

Interface Level Level=Interface Level
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For measuring the interface level, the transmitter uses the residual wave of 
the first reflection. Part of the wave, which was not reflected at the upper 
product surface, continues until it is reflected at the lower product surface. 
The speed of this wave depends fully on the dielectric constant of the upper 
product.

If interface is to be measured, the following criteria have to be fulfilled:
• The dielectric constant of the upper product must be known. The Radar 

Configuration Tools software has a built-in dielectric constant calculator 
to assist users in determining the dielectric constant of the upper 
product (see “Dielectrics” on page 4-21).

• The dielectric constant of the upper product must have a lower 
dielectric constant than the lower product in order to have a distinct 
reflection.

• The difference between the dielectric constants for the two products 
must be larger than 10.

• Maximum dielectric constant for the upper product is 10 for the coaxial 
probe and 5 for twin lead probes.

• The upper product thickness must be larger than 8 inches (0.2 m) for 
the flexible twin lead probe and 4 inches (0.1 m) for the rigid twin lead 
and coaxial probes in order to distinguish the echoes of the two liquids.

The maximum allowable upper product thickness/measuring range is 
primarily determined by the dielectric constants of the two liquids. 

Target applications include interfaces between oil/oil-like and water/water-like 
liquids. For such applications the upper product dielectric constant is low (<3) 
and the lower product dielectric constant is high (>20), and the maximum 
measuring range is only limited by the length of the coaxial and rigid twin lead 
probes.

For the flexible twin lead probe, the reduction of maximum measuring range 
(65 ft/20 m), can be gained from Figure 2-7 on page 2-10.

However, characteristics varies widely between different applications. For 
other product combinations, consult factory.

Figure 2-7. Reduction of 
maximum measuring range for 
Flexible Twin Lead probe

Reduction of Maximum Measuring Range for 
different Upper Product Dielectric constants.
Flexible Twin Lead probe (ft/m) 

Maximum Upper Product Thickness (ft/m)
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Emulsion Layers

Sometimes there is an emulsion layer (mix of the products) between the two 
products which, depending on its characteristics, will affect interface 
measurements.

Please consult factory for guidelines on how to handle emulsion layers. 

VESSEL 
CHARACTERISTICS

Heating Coils, Agitators The Rosemount 3300 Series Radar Transmitter is relatively insensitive to 
objects in the tank since the radar signal is transmitted along a probe. 

Avoid physical contact between probes and agitators as well as applications 
with strong fluid movement unless the probe is anchored. If the probe can 
move within 1 ft (30 cm) away from any object, such as an agitator, during 
operation then probe tie-down is recommended.

In order to stabilize the probe for side forces, it is possible to hang a weight at 
the probe end (flexible probes only) or fix/guide the probe to the tank bottom.

Tank Shape The guided wave radar transmitter is insensitive to the tank shape. Since the 
radar signal travels along a probe, the shape of the tank bottom has virtually 
no effect on the measurement performance. The transmitter handles flat or 
dish-bottom tanks equally well. 
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Section 3 Installation
Safety messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 3-1
Installation Procedure  . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 3-3
Before You Install  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 3-4
Mounting Considerations  . . . . . . . . . . . . . . . . . . . . . . . . . page 3-6
Mechanical Installation  . . . . . . . . . . . . . . . . . . . . . . . . . . . page 3-13
Electrical Installation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 3-21
Optional Devices . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 3-26

SAFETY MESSAGES Procedures and instructions in this section may require special precautions to 
ensure the safety of the personnel performing the operations. Information that 
raises potential safety issues is indicated by a warning symbol ( ). Please 
refer to the following safety messages before performing an operation 
preceded by this symbol.

Explosions could result in death or serious injury:
Verify that the operating environment of the transmitter is consistent with the appropriate 
hazardous locations certifications.

Before connecting a HART-based communicator in an explosive atmosphere, make 
sure the instruments in the loop are installed in accordance with intrinsically safe or 
non-incendive field wiring practices.

Do not remove the gauge cover in explosive atmospheres when the circuit is alive.

Failure to follow safe installation and servicing guidelines could result in death or 
serious injury:
Make sure only qualified personnel perform the installation.

Use the equipment only as specified in this manual. Failure to do so may impair the 
protection provided by the equipment.

Do not perform any service other than those contained in this manual unless you are 
qualified.

Process leaks could result in death or serious injury.
Make sure that the transmitter is handled carefully. If the Process Seal is damaged, gas 
might escape from the tank if the transmitter head is removed from the probe.
www.rosemount.com
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High voltage that may be present on leads could cause electrical shock:
Avoid contact with leads and terminals. 

Make sure the main power to the 3300 transmitter is off and the lines to any other 
external power source are disconnected or not powered while wiring the gauge.

Probes covered with plastic and/or with plastic discs may generate an ignition-capable 
level of electrostatic charge under certain extreme conditions. Therefore, when the 
probe is used in a potentially explosive atmosphere, appropriate measures must be 
taken to prevent electrostatic discharge.
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INSTALLATION 
PROCEDURE

Follow these steps for proper installation:

NOTE!
Disconnect power supply before setting the Write Protection.

Review Installation 
Considerations
(see page 3-6)

Check switches for 
4-20 mA AlarmOutput

(see page 3-4)

Mount the transmitter
(see page 3-13)

Wire the transmitter
(see page 3-21)

Make sure covers 
and cable/conduit 
connections are 

tight.

Power Up the 
transmitter

Configure the 
transmitter

(see page 4-1)

Verify measurements

Set the Write 
Protection Switch
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BEFORE YOU INSTALL

Alarm and Write 
Protection Switches

Electronic boards are electrostatically sensitive. Failure to observe proper 
handling precautions for static-sensitive components can result in damage to 
the electronic components. Do not remove the electronic boards from the 
3300 Radar Transmitter.

NOTE
To ensure long life for your radar transmitter, and to comply with hazardous 
location installation requirements, tighten covers on both sides of the 
electronics housing.

The transmitter monitors its own operation. This automatic diagnostic routine 
is a timed series of checks repeated continuously. If the diagnostic routine 
detects a failure in the transmitter, the 4–20 mA output is driven upscale (high) 
or downscale (low) depending on the position of the Alarm switch.

Security write protection prevents unauthorized access to configuration data 
through the Rosemount Configuration Tool (RCT) software, a Field 
Communicator or AMS Suite software.

Table 3-1.  3300 Radar Transmitter Switch Settings
Switch 
Bank Description Default Setting Position Settings

Alarm 4–20 mA Alarm Output High High, Low

Write 
Protect

Security Write 
Protection

Disabled (OFF) ON = Enabled, 
OFF = Disabled

Table 3-2.  Analog Output: Standard Alarm Values vs. Saturation Values
Level 4–20 mA Saturation Values 4–20 mA Alarm Value

Low 3.9 mA 3.75 mA

High 20.8 mA 21.75 mA

Table 3-3.  Analog Output: NAMUR-Compliant Alarm Values vs. Saturation 
Values

Level 4–20 mA Saturation Values 4–20 mA Alarm Value

Low 3.8 mA 3.6 mA

High 20.5 mA 22.5 mA
3-4

Rick Hurdle
Highlight

Rick Hurdle
Highlight

Rick Hurdle
Highlight



Reference Manual 
00809-0100-4811, Rev CA
February 2006 Rosemount 3300 Series
Figure 3-1. Switches for Alarm 
and Write Protection

To set the Alarm and Write Protect switches do the following:

1. Remove the cover on the circuit side (see main label).
2. To set the 4-20 mA alarm output to Low, move the Alarm switch to the 

LOW position. HIGH is the factory default setting (see Figure 3-1).
3. To enable the security write protection feature, move the Write Protect 

switch to the ON position. The OFF position is the factory default setting 
(see Figure 3-1).

4. Replace and tighten the cover.

Alarm Output

Write Protection
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MOUNTING 
CONSIDERATIONS

Before you install the Rosemount 3300 Series Radar Transmitter, be sure to 
consider specific mounting requirements, vessel characteristics and process 
characteristics.

Process Connection The 3300 Series has a threaded connection for easy mounting on the tank 
roof. It can also be mounted on a nozzle by using different flanges.

Threaded Connection

Figure 3-2. Mounting on tank 
roof using threaded connection 

Mounting on tank roof.

Mounting in threaded pipe.
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Flange Connection on Nozzles

Figure 3-3. Mounting in nozzles

The transmitter can be mounted in nozzles by using an appropriate flange. It 
is recommended that the nozzle size is within the dimensions given in 
Table 3-4. For small nozzles it may be necessary to increase the Upper Null 
Zone (UNZ) in order to reduce the measuring range in the upper part of the 
tank. By setting the UNZ equal to the nozzle height, the impact on the 
measurement due to interfering echoes from the nozzle will be reduced to a 
minimum. See also section “Disturbances at the Top of the Tank“ on 
page 6-11. Amplitude Threshold adjustments may also be needed in this 
case.

NOTE
Except for the Coaxial Probe the probe must not be in contact with the nozzle. 

H

D2=min. diameter with 
Upper Null Zone adjustment

HUNZ
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Avoid nozzles 
with reducer

D1=min. diameter

Table 3-4.  Minimum nozzle diameter D1/D2 and maximum nozzle height H (inch/mm).

Rigid Twin Lead Flexible Twin Lead Coaxial Single Lead Flexible Single

D1(1) 4/100 4/100 > Probe diameter 6/150 6/150

D2(2) 2/50 2/50 > Probe diameter 2/50(3)

1.5/38(4)
2/50

H(5) 4/100 + D(6) 4/100 + D(6) - 4/100 + D(6) 4/100 + D(6) (7)

(1) Upper Null Zone=0.
(2) Upper Null Zone>0. 
(3) Process connection 1.5 inch.
(4) Process connection 1 inch.
(5) Recommended maximum nozzle height. For coaxial probes there is no limitation on nozzle height.
(6) Nozzle diameter. 
(7) For tall nozzles the Long Stud version is recommended (option code LS).
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Installation of Single 
Lead Probes in 
Non-metallic Tanks

For optimal single lead probe performance in non-metallic tanks the probe 
must be mounted with a metal flange, or screwed in to a metal sheet (d>8 
in./200 mm) if the threaded version is used.

Figure 3-4. Mounting in 
non-metallic tanks.

Avoid disturbing EMC environment near the tank. Installation in metallic tank 
is recommended.

Metal flange Ø>2”/DN50 

Metal sheet Ø>8”/200 mm
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Mounting in Still 
pipes/by-pass pipes

In order to prevent the probe from contacting the bridle wall when replacing 
displacers or installing in pipes, centering discs are available for the Rigid 
Single, Flexible Single and Flexible Twin Lead probes. The disc is attached to 
the end of the probe and thus keeps the probe centered in the bridle. The 
discs are available in stainless steel and teflon (PTFE). See also “Mounting a 
Centering Disc for Pipe Installations“ on page 3-20.

Figure 3-5. Mounting in 
Still Pipes.

Note! It is not recommended that flexible 
probes are installed in by-pass pipes.

Rigid Single Lead.
Pipe diameter Ø≥2 inch (50 mm).
Inlet pipe diameter N<Ø.
L≥12 inch (300 mm).

Flexible Single Lead.
Pipe diameter Ø≥4 inch (100 mm).
Note! For smaller pipes please consult 
factory.

Make sure that the probe is at the center of 
the Still pipe by, for example, using a 
centering disc.

Note! It is not recommended that flexible 
probes are installed in by-pass pipes.
Rigid Twin Lead.
Pipe diameter Ø≥2 inch (50 mm).
Inlet pipe diameter N<Ø.
L≥12 inch (300 mm).
The center rod must be placed more than 
0.6 inch/15 mm away from the pipe wall. 

Flexible Twin Lead.
Pipe diameter Ø≥4 inch (100 mm).
Note! For smaller pipes please consult 
factory.
The center rod must be placed more than 
0.6 inch/15 mm away from the pipe wall. The 
probe may under no circumstances get into 
contact with the pipe wall. It is recommended 
that a centering disc is used.

Coaxial Lead.
Pipe diameter Ø≥1.5 inch (38 mm).
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Free Space For easy access to the transmitter make sure that it is mounted with sufficient 
service space. For maximum measurement performance the transmitter 
should not be mounted too close to the tank wall or other objects in the tank. 

If the probe is mounted close to a wall, nozzle or other tank obstruction noise 
might appear in the level signal. Therefore the following minimum clearance, 
according to the table below, must be maintained:

Figure 3-6. Free Space 
Requirement

Table 3-5.  Recommended minimum free space L to tank wall or other objects 
in the tank.

Coaxial Rigid Twin Flexible Twin

0 in. (0 mm) 4 in. (100 mm) 4 in. (100 mm)

Table 3-6.  Recommended minimum free space L to tank wall or other objects 
in the tank for Single Lead probes.

Rigid Single/Flexible Single

4 in. (100 mm) Smooth metal wall.

12 in. (300 mm) Disturbing objects such as pipes and 
beams, concrete or plastic tank walls, 
rugged metal tank walls.
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Recommended Mounting 
Position

When finding an appropriate mounting position for the transmitter the 
conditions of the tank must be carefully considered. The transmitter should be 
mounted so that the influence of disturbing objects is reduced to a minimum.

In case of turbulence the probe may need to be anchored to the bottom. See 
“Mechanical Installation“ on page 3-13 for more information. 

Figure 3-7. Mounting Position

The following guidelines should be considered when mounting the transmitter:
• Do not mount close to inlet pipes.
• Do not mount close to agitators. If the probe can move to within 30 cm 

away from an agitator a probe tie-down is recommended.
• If the probe tends to sway due to turbulent conditions in the tank, the 

probe should be anchored to the tank bottom.
• Avoid mounting close to heating coils.
• Make sure that the nozzle does not extend into the tank.
• Make sure that the probe does not come into contact with the nozzle or 

other objects in the tank.
• Position the probe such that it is subject to a minimum of lateral force.

NOTE!
Violent fluid movements causing high sideway forces may break rigid probes.

Inlet pipe

Heating coils

Agitator
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Insulated Tanks For insulated tanks the permitted ambient temperature is limited above a 
certain process temperature. Limitations depend on the thickness of the tank 
insulation, see “Ambient Temperature“ on page A-6 for more information.

Figure 3-8. Maximum ambient 
temperature vs. process 
temperature.
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MECHANICAL 
INSTALLATION

Mount the transmitter with flange on a nozzle on top of the tank. The 
transmitter can also be mounted on a threaded connection. Make sure only 
qualified personnel perform the installation.

NOTE
If you need to remove the transmitter head from the probe, make sure that the 
Process Seal is carefully protected from dust and water. See “Service“ on 
page 6-9 for further information.

Figure 3-9. Tank connection with 
flange.

Figure 3-10. Tank connection 
with loose flange (“plate 
design”).

1. Place a gasket on top of the tank flange.
2. Lower the transmitter and probe with 

flange into the tank. 
3. Tighten the bolts.
4. Loosen the nut that connects the 

transmitter housing to the probe slightly.
5. Rotate the transmitter housing so the 

cable entries/display face the desired 
direction.

6. Tighten the nut.

NOTE!
PTFE covered probes must be handled 
carefully to prevent damage to the coating.

Transmitter head
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Tank flange
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Probe
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The transmitter is delivered with head, flange 
and probe assembled into one unit. If, for som 
reason, these parts have been disassembled 
mount the transmitter as described below:

1. Place a gasket on top of the tank flange.
2. Mount the flange on the probe and 

tighten the flange nut. 
3. Mount the transmitter head.
4. Lower the transmitter and probe with 

flange into the tank. 
5. Tighten the bolts.
6. Loosen the nut that connects the 

transmitter housing to the probe slightly.
7. Rotate the transmitter housing so the 

cable entries/display face the desired 
direction.

8. Tighten the nut.
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Figure 3-11. Threaded tank 
connection.

1. For tank connections with BSP/G threads, 
place a gasket on top of the tank flange, or 
use a sealant on the threads of the tank 
connection.

2. Lower the transmitter and probe into the 
tank. 

3. Screw the adapter into the process 
connection. 

4. Loosen the nut that connects the 
transmitter housing to the probe slightly.

5. Rotate the transmitter housing so the 
cable entries/display face the desired 
direction.

6. Tighten the nut.

NOTE!
For adapters with NPT threads, pressure-tight 
joints require a sealant.

Sealant on threads or 
gasket (for BSP/G threads)

Nut

Tank connection

Probe

TR
A

N
S

M
IT

TE
R

_M
O

U
N

T_
TH

R
E

A
D

.E
P

S

3-14



Reference Manual 
00809-0100-4811, Rev CA
February 2006 Rosemount 3300 Series
Shortening the Probe Flexible Twin/Single Lead

Rigid Single Lead

1. Cut the Single Lead probe to the desired length.
2. Update the transmitter configuration to the new probe length, see “Probe 

Length“ on page 4-9.

NOTE!
The PTFE covered probes must not be cut in field.

1. Mark off the required probe length. Add at 
least 1.6 inch/40 mm to the required probe 
length to be inserted into the weight.

2. Loosen the Allen screws. 
3. Slide the weight upwards as much as 

needed in order to cut the probe.
4. Cut the probe. If necessary, remove a 

spacer to make room for the weight.
5. Slide the weight down to the required 

cable length.
6. Tighten the screws.
7. Update the transmitter configuration to the 

new probe length, see “Probe Length“ on 
page 4-9.

If the weight was removed from the cables 
when cutting, make sure that at least 1.6 
inch/40 mm of the cable is inserted when the 
weight is replaced. 

Allen 
screws
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1.6 inch/
40 mm
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Cut
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Rigid Twin Lead

The spacers are put closer together at the probe end. The maximum amount 
that can be cut away is related to the ordering length L. 

To cut a Rigid Twin Lead probe do the following:

1. Cut the rods to the desired length:
• You may cut up to 19.7 inch (500 

mm) from the probe end for probe 
length L above 46.5 in. (1180 mm).

• For probe length 
20.5 to 46.5 in. (520 to 1180 mm) 
the minimium length is 
20.5 in. (520 mm).

• For probe length 15.7 to 20.5 in. 
(400 to 520 mm) the minimium 
length is 15.7 in. (400 mm).

2. Update the transmitter configuration 
to the new probe length, see “Probe 
Length“ on page 4-9.

Max. shortening length: 
19.7 in. / 500 mm
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Coaxial
To cut a coaxial probe do the 
following:

NOTE!
The HTHP coaxial probe must not be 
cut in field.

1. Insert the centering piece.
(The centering piece is 
delivered from factory and 
should be used to prevent the 
spacers centering the rod from 
coming loose).

2. Cut the tube to the desired length.
3. Move the centering piece.
4. Cut the rod inside the tube. Make 

sure that the rod is fixed with the 
centering piece while cutting.

• Pipes longer than 
49 inches/1250 mm can be 
shortened by as much as 
23.6 inches/600 mm.

• Pipes shorter than 
49 inches/1250 mm can be cut as 
long as the remaining length is not 
less than 
15.7 inches/400 mm.

5. Update the transmitter 
configuration to the new probe 
length, see “Probe Length“ on 
page 4-9.
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Anchoring In turbulent tanks it may be necessary to fix the probe. Depending on the 
probe type different methods can be used to guide the probe to the tank 
bottom. This may be needed in order to prevent the probe from hitting the 
tank wall or other objects in the tank, as well as preventing a probe from 
breaking.

Flexible Twin/Single Lead probe 
with weight and ring.

A ring (customer supplied) can be 
attached to the weight in a threaded 
(M8x14) hole at the end of the 
weight. Attach the ring to a suitable 
anchoring point.

Flexible Twin/Single Lead probe 
with weight and magnet.

A magnet (customer supplied) can 
be fastened in a threaded (M8x14) 
hole at the end of the weight. The 
probe can then be guided by placing 
a suitable metal plate beneath the 
magnet.

Coaxial probe fixed to the tank wall.

The coaxial probe can be guided to 
the tank wall by fixtures fastened to 
the tank wall. Fixtures are customer 
supplied. Make sure the probe can 
move freely due to thermal 
expansion without getting stuck in 
the fixture.

Weight with 
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Coaxial probe.

The Coaxial probe can be guided by 
a tube welded on the tank bottom. 
Tubes are customer supplied. Make 
sure that the probe can move freely 
in order to handle thermal expansion.

Rigid Twin Lead probe.

The Rigid Twin Lead probe can be 
secured to the tank wall by cutting 
the center rod and putting a fixture at 
the end of the outer rod.

The fixture is customer supplied. 
Make sure the probe is only guided 
and not fastened in the fixture to be 
able to move freely for thermal 
expansion.

Flexible Single Lead probe.

The probe rope itself can be used for 
anchoring. Pull the probe rope 
through a suitable anchoring point, 
e.g. a welded eye and fasten it with 
two clamps.

The length of the loop will add to the 
dead zone.The location of the 
clamps will determine the beginning 
of the dead zone. The probe length 
should be configured as the length 
from the underside of the flange to 
the top clamp. See section “Dead 
Zones“ on page 2-7 for further 
information on Dead Zones.
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Mounting a Centering 
Disc for Pipe 
Installations

Flexible Single/Twin Lead probe

Rigid Single Lead probe

NOTE!
Centering discs may not be used with PTFE covered probes.

1. Mount the centering disc at the 
end of the weight.

2. Make sure that the tab washer is 
properly inserted in the centering 
disc.

3. Fasten the centering disc with 
the bolt.

4. Secure the bolt by folding the tab 
washer.

NOTE!
Centering discs made of PTFE must 
not be used with the Rosemount 3300 
HTHP version.

Centering disc

Weight

Bolt

Tab washer

Tab washer

1. Mount the centering disc at the 
end of the probe.

2. Fasten the disc by inserting the 
split pin through the bushing 
and the probe.

3. Secure the split pin.

Bushing

Split pin
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ELECTRICAL 
INSTALLATION

Cable/conduit entries The electronics housing has two entries for ½ - 14 NPT. Optional M20×1.5 
and PG 13.5 adapters are also available. The connections are made in 
accordance with local or plant electrical codes.

Make sure that unused ports are properly sealed to prevent moisture or other 
contamination from entering the terminal block compartment of the electronics 
housing. 

NOTE!
Use the enclosed metal plug to seal the unused port.

Grounding The housing should always be grounded in accordance with national and 
local electrical codes. Failure to do so may impair the protection provided by 
the equipment. The most effective grounding method is direct connection to 
earth ground with minimal impedance. There are two grounding screw 
connections provided. One is inside the Field Terminal side of the housing 
and the other is located on top of the housing. The internal ground screw is 
identified by a ground symbol: .

NOTE!
Grounding the transmitter via threaded conduit connection may not provide 
sufficient ground.

NOTE!
In the Explosion-proof/Flame-proof version the electronics is grounded via the 
transmitter housing. After installation and commissioning make sure that no 
ground currents exist due to high ground potential differences in the 
installation.

Cable Selection Use shielded twisted pair wiring for the Rosemount 3300 Series in order to 
comply with EMC regulations. The cables must be suitable for the supply 
voltage and approved for use in hazardous areas, where applicable. For 
instance, in the U.S., explosion-proof conduits must be used in the vicinity of 
the vessel. For the ATEX flame proof approval version of the 3300 Series, 
suitable conduits with sealing device or flame proof (EEx d) cable glands must 
be used depending on local requirements.

Use 18 AWG to 12 AWG in order to minimize the voltage drop to the 
transmitter.

Hazardous Areas When the 3300 transmitter is installed in hazardous area, local regulations 
and specifications in applicable certificates must be observed.
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Power Requirements Terminals in the transmitter housing provide connections for signal cables.

The 3300 transmitter is loop-powered and operates with power supplies 
ranging from 11 to 42 VDC. For Intrinsically Safe output the supply voltage 
must be within 11 to 30 VDC. For Explosion-proof/Flame-proof the supply 
voltage must be within 16 to 42 VDC.

Maximum Loop 
Resistance

The maximum current loop resistance can be gained from the following 
diagrams:

Figure 3-12. Explosion-proof 
/Flame-proof installations

Figure 3-13. Non-hazardous 
installations

Figure 3-14. Intrinsically Safe 
installations
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Connecting the 
Transmitter

The 3300 Series is a two-wire loop powered transmitter accepting power 
supplies ranging from 11 VDC to 42 VDC. It uses 4-20 mA power 
superimposed with a HART signal.

To connect the transmitter:

1. Make sure that the power supply is disconnected.
2. Remove the cover on the transmitter housing terminal side (see label).

3. Pull the cable through the cable gland/conduit.
4. Connect wires according to Figure 3-15 for non-intrinsically safe output 

and according to Figure 3-16 for Intrinsically safe output. Make sure that 
the transmitter housing is grounded (see “Grounding“ on page 3-21).

5. Replace the cover, tighten the cable gland and connect the power 
supply.
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Non-Intrinsically Safe 
Output

For non-intrinsically safe installations, wire the transmitter as shown in 
Figure 3-15. 

NOTE!
Make sure that the power supply is off when connecting the transmitter.

Figure 3-15. Wiring diagram for 
non-intrinsically safe 
installations.

For HART communication a minimum load resistance of 250 Ohm within the 
loop is required. For maximum load resistance see Figure 3-12 
(Explosion/Flame Proof) and Figure 3-13 (Non-hazardous installations).

The power supply voltage ranges from Vmin VDC to 42 VDC where Vmin is the 
minimum voltage given by:

For Explosion-proof/Flame-proof applications the resistance between the 
negative terminal on the transmitter and the power supply must not exceed 
300 Ohm.

NOTE!
EEx d version: If there is a risk for a difference in voltage potential between 
transmitter ground an power supply ground, a galvanic isolator is required.

 

Load Resistance = 250 Ω

Power Supply

375 Field 
Communicator

Model 3300 Radar 
Transmitter

HART modem

PC

W
IR

IN
G

 N
O

N
 IS

Vmin - 42 VDC

Ground Connection

11 V Non-hazardous locations certification
16 V Explosion-proof/flame-proof certification
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Intrinsically Safe Output For intrinsically safe installations wire the transmitter as shown in Figure 3-16.

NOTE!
Make sure that the instruments in the loop are installed in accordance with 
intrinsically safe field wiring practices and System Control Drawings when 
applicable.

Figure 3-16. Wiring diagram for 
intrinsically safe installations

For HART communication a minimum load resistance of 250 Ohm within the 
loop is required. For maximum load resistance see Figure 3-14. 

The power supply voltage ranges from 11 V to 30 V.

IS parameters

Ui=30 V.

Ii=130 mA.

Pi=1 W.

Ci=0.

Li=0.

 

DCS

RL=250 Ω

Approved IS barrier
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Power Supply
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Transmitter
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11 - 30 VDC

Ground Connection
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OPTIONAL DEVICES

Tri-Loop The Model 3300 transmitter outputs a HART signal with four process 
variables. By using the Model 333 HART Tri-Loop up to three additional 
analog 4-20 mA outputs are provided.

Figure 3-17. Wiring diagram for 
HART Tri-Loop

Configure Channels 1, 2, and 3 to reflect the units as well as Upper Range 
Values and Lower Range Values for your secondary, tertiary and fourth 
variables (variable assignment is configured in the Model 3300). It is also 
possible to enable or disable a channel from this menu. See “Special 
Functions“ on page 4-24 for further information on how to install a Tri-Loop.

Ch. 3
Ch. 2
Ch. 1

Each Tri-Loop 
Channel 
recieves power 
from Control 
Room

Channel 1 must 
be powered for 
the Tri-Loop to 
operate

Device recieves 
power from 
Control Room

RL ≥ 250 Ω

HART Burst Command 3/
Analog Output

Intrinsically Safe Barrier

DIN Rail Mounted
HART Tri-Loop

Control Room

W
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P

Burst Input 
to Tri-Loop
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Using More than one 
transmitter on the bus

The 3300 transmitter can be run in multidrop mode. In the multidrop mode 
each transmitter has a unique HART address.

Figure 3-18. Multidrop 
connection

The poll address can be changed by using a 375 Field Communicator or by 
using the Rosemount Configuration Tools software.

To change the poll address using a 375 Field Communicator choose HART 
command [1, 4, 5, 2, 1].

To change the poll address using the Rosemount Configuration Tools (RCT) 
software do the following:

1. Choose the View>Device Commands option.
or
choose the Device Commands icon from the Project Bar Advanced 
section.

2. Open the Details folder.
3. Choose the Set Poll Address option.
4. Set the desired address.
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751 Field Signal Indicator

Figure 3-19. Wiring diagram for 
3300 transmitter with 751 Field 
Signal Indicator

Figure 3-20. Alternative wiring 
diagram for 3300 transmitter 
with 751 Field Signal Indicator
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Section 4 Start-Up
Safety messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 4-1
Configuration Parameters  . . . . . . . . . . . . . . . . . . . . . . . . . page 4-2
Configuration using a 375 Field Communicator  . . . . . . . page 4-7
Configuration using The Radar Configuration Tool  . . . . page 4-14
Special Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 4-24

SAFETY MESSAGES Procedures and instructions in this section may require special precautions to 
ensure the safety of the personnel performing the operations. Information that 
raises potential safety issues is indicated by a warning symbol ( ). Refer to 
the safety messages listed at the beginning of each section before performing 
an operation preceded by this symbol.

Explosions could result in death or serious injury:
Verify that the operating environment of the gauge is consistent with the appropriate 
hazardous locations certifications.

Before connecting a HART-based communicator in an explosive atmosphere, make 
sure the instruments in the loop are installed in accordance with intrinsically safe or 
non-incendive field wiring practices.

Do not remove the gauge cover in explosive atmospheres when the circuit 
is alive.

Failure to follow safe installation and servicing guidelines could result in death or 
serious injury:
Make sure only qualified personnel perform the installation.

Use the equipment only as specified in this manual. Failure to do so may impair the 
protection provided by the equipment.

Do not perform any service other than those contained in this manual unless you are 
qualified.
www.rosemount.com
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CONFIGURATION 
PARAMETERS

The Rosemount 3301 transmitter can be configured for level and volume 
measurements. The Rosemount 3302 is designed to measure interface level 
and interface distance as well. 

The 3300 transmitter can be pre-configured according to the ordering 
specifications in the Configuration Data Sheet.

Basic Configuration The basic transmitter configuration includes setting the tank geometry 
parameters. For interface measurements the dielectric constant of the top 
liquid must also be given. For some applications with heavy vapor, the vapor 
dielectric must be given as well.

Figure 4-1. Tank Geometry

Figure 4-2. Upper Reference 
Point

For the different tank connections the Upper Reference Point is located at the 
underside of the threaded adapter or at the underside of the welded flange, as 
illustrated in Figure 4-2:
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Reference Gauge Height

The Reference Gauge Height is the distance from the Upper Reference Point 
to the bottom of the tank. The transmitter measures the distance to the 
product surface and subtracts this value from the Reference Gauge Height to 
determine the level.

Probe Length

The probe length is the distance between the Upper Reference Point and the 
end of the probe. If a weight is used at the end of the probe it shall not be 
included.

For Flexible Single Lead probes anchored with clamps, the probe length 
should be configured as the distance between the underside of the flange and 
the upper clamp (see “Anchoring” on page 3-18).

This parameter is pre-configured at factory. It must be changed if the probe is 
shortened.

Probe Type

The transmitter is designed to optimize measurement performance for each 
probe type. 

This parameter is pre-configured at factory. This value needs to be changed if 
the probe type is changed.

Flexible and Rigid probes require different radar electronics and can not be 
used with the same transmitter head.

Dielectric Constant of Upper Product

For interface measurements the dielectric constant of the upper product is 
essential in order to obtain good accuracy. See section “Interface” on 
page 2-9 for further information on dielectric constants. 

If the dielectric constant of the lower product is significantly smaller than the 
dielectric constant of water, you may need to make special adjustments. See 
section “Interface Measurements for Semi-Transparent Bottom Products” on 
page 6-5 for further information. 

For level measurements the Upper Product Dielectric parameter corresponds 
to the actual dielectric constant of the product in the tank. Normally this 
parameter does not need to be changed even if the actual dielectric constant 
of the product deviates from the Upper Product Dielectric parameter value. 
However, for some products measurement performance can be optimized by 
setting the proper product dielectric constant.

Dielectric Constant of Vapor

In some applications there is heavy vapor above the product surface having a 
significant influence on the level measurement. In such cases the vapor 
dielectric can be entered to compensate for this effect.

The default value is equal to 1 which corresponds to the dielectricity of 
vacuum. Normally this value does not need to be changed since the effect on 
measurement performance is very small for most vapors.
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Upper Null Zone

This parameter should only be changed if there are measurement problems in 
the upper part of the tank. Such problems may occur if there are disturbing 
objects close to the probe. By setting the Upper Null Zone the measuring 
range is reduced. See Section 6: Disturbances at the Top of the Tank for 
further information.

4 mA point

The 4 mA point should be set above the Lower Dead Zone (see Section 2: 
Dead Zones). If the 4 mA point is set to a point within the Dead Zone or below 
the probe end, the full range of the analog output is not used.

20 mA point

Make sure that the 20 mA point is below the Upper Null Zone. 

The 20 mA point should be set below the Upper Dead Zone (see “Dead 
Zones” on page 2-7). If the 20 mA point is set to a point within the Dead Zone 
the full range of the analog output is not used.

Probe angle

If the transmitter is not mounted vertically, the angle from the vertical position 
must be given.
4-4

Rick Hurdle
Highlight

Rick Hurdle
Highlight



Reference Manual 
00809-0100-4811, Rev CA
February 2006 Rosemount 3300 Series
Volume Configuration For volume calculations you can choose one of the standard tank shapes or 
the strapping option. Choose None if volume calculation is not used.

Tank Type

You can choose one of the following options:
• Strap table
• Vertical Cylinder
• Horizontal Cylinder
• Vertical Bullet
• Horizontal Bullet
• Sphere
• None

Strapping Table

Use a strapping table if a standard tank type does not provide sufficient 
accuracy. Use most of the strapping points in regions where the tank shape is 
non-linear. A maximum of 10 points can be added to the strapping table.

Figure 4-3. Strapping points

Actual tank bottom may look like this.

Using only 3 strapping points results in a level-to-volume profile 
that is more angular than the actual shape.

Using 6 of the points at the bottom of the tank yields a 
level-to-volume profile that is similar to the actual tank bottom.
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Standard Tank Shapes

Figure 4-4. Standard tank 
shapes

Vertical Cylinder

Vertical Cylinder tanks are specified by 
Diameter and Height.

Horizontal Cylinder

Horizontal Cylinders are specified by 
Diameter and Height.

Vertical Bullet

Vertical Bullet tanks are specified by 
Diameter and Height. The volume 
calculation model for this tank type 
assumes that the radius of the bullet 
end is equal to the Diameter/2.

Horizontal Bullet

Horizontal Bullets are specified by 
Diameter and Height. The volume 
calculation model for this tank type 
assumes that the radius of the bullet 
end is equal to the Diameter/2.

Sphere

Spherical tanks are specified by 
Diameter.
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CONFIGURATION USING 
A 375 FIELD 
COMMUNICATOR

This section describes how to configure the 3300 transmitter by using a 375 
Field Communicator. A 275 HART Communicator may also be used.

For information on all the capabilities, refer to the 375 Field Communicator 
Product Manual (document 00809-0100-4276).

Figure 4-5. The 375 Field 
Communicator.
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Figure 4-6. HART Communicator Menu Tree corresponding to Device Revision 2.

Online Menu

1 DEVICE SETUP
2 PV
3 AO
4 LRV
5 URV

1 Device 
Information

3 Volume 
Geometry

4 HART

5 Advanced 
Service

1 Variable mapping
2 Level
3 Distance
4 Volume
5 Internal Temp
6 Interface Dist
7 Interface Level
8 Amplitude Peak 1
- Amplitude Peak 2
- Amplitude Peak 3
- Upper Prod Thickn

1 Process 
Variables

2 Diag/Service

3 Basic Setup

4 Detailed Setup

5 Review

1 Measurem Units
1 Level Unit
2 Volume Unit
3 Temperature Unit

1 Distributor
2 Model
3 Dev Id
4 Tag
5 Descriptor
6 Message
7 Date
8 Write Protect
9 Revision #´s

1 Tank Type
2 Tank Diameter
3 Tank Height

1 Gain Control
2 Max Up Prod Tkn
3 Thresholds
4 Reset to Default
5 Calibration Offst

1 Flange Type
2 Flange Material
3 Probe
4 Barrier- Construction Details

1 Entries Used
2 Max Entries
3 Lvl0
4 Vol0
5 Lvl1
6 Vol1
7 Lvl2
8 Vol2
9 Lvl3

Vol3

Lvl9
Vol9

1 Poll addr
2 Num req preamps
3 Burst mode
4 Burst option

1 Strap Table
2 Ver Cylinder
3 Hor Cylinder
4 Vert Bullet
5 Hor Bullet
6 Sphere
7 None

4 Strapping Table

1 Variable re-map
2 PV is
3 SV is
4 TV is
5 QV is

- Level
- Distance
- Volume
- Internal Temp
- Interface Dist
- Interface Level
- Amplitude Peak 1
- Amplitude Peak 2
- Amplitude Peak 3
- Upper Prod Thickn

1 Status Group 1
2 Status Group 2

To enable volume
calculations based on 
a strapping table, the 
“Strapping Table” 
option must be 
selected for tank type

2 Display

1 Universal rev
2 Fld dev rev
3 Software rev

1 Display variables
2 Display language

1 PV is
2 Apply values
3 Range values
4 AO Values

1 Status
2 Master Reset
3 Loop Test
4 D/A Trim
5 Scaled D/A Trim
6 PV AO
7 PV AO Alarm Type

1 Ref Height
2 Probe Length
3 Probe Type
4 Probe Angle
5 Show Lvl=0

1 Upper Null Zone
2 Vapor Dielectric
3 Product Dielectric
4 Measurement Mode

3 Misc. settings

2 Geometry/Probe

4 Analog output

5 Damping Value
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BASIC CONFIGURATION This section describes the various HART commands used to configure the 
3300 Series of transmitters for level measurements. The transmitter outputs a 
4 - 20 mA signal proportional to the primary variable. Three additional 
variables are available through the HART signal.

Transmitter Variables
You may assign up to four transmitter variables. Typically, the primary variable 
(PV) is configured to be Aggregate Level, Interface Level or Volume. 

For the model 3301 the primary variable is typically set to be Level. If the 
transmitter is in the Immerse Probe mode (see section Measurement Mode) 
the PV is normally set to Interface Level.

For the model 3302 the PV is typically set to Interface Level, but Level and 
other options may also be used. 

Measurement Units
Set transmitter units for level and temperature.

Reference Gauge Height
The Reference Gauge Height is the distance from the Upper Reference Point 
to the bottom of the tank (see Figure 4-1 on page 4-2). When setting the 
Reference Gauge Height, keep in mind that this value is used for all level 
measurements performed by the 3300 Series transmitter. 

The Reference Gauge Height must be set in linear (level) units, such as feet 
or meters, regardless of primary variable assignment.

Probe Length
The probe length is the distance from the Upper Reference Point to the end of 
the probe, see Figure 4-1. If the probe is anchored to a weight do not include 
the height of the weight. This parameter is pre-configured at factory. The 
Probe Length needs to be changed if, for example, the probe is shortened.

HART Comm 1, 1, 1, 1

HART Comm 1, 3, 1

HART Comm 1, 3, 2, 1

HART Comm 1, 3, 2, 2
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Probe Type
The transmitter automatically makes an initial calibration based on the type of 
probe that is used. This parameter is pre-configured at factory and only needs 
to be set if the probe is changed to another type. Choose one of the following 
options:

• Rigid Twin
• Flexible Twin
• Coaxial, Coaxial HP, Coaxial HTHP
• Rigid Single, Rigid Single HTHP, Rigid Single PTFE
• Flexible Single, Flexible Single HTHP, Flexible Single PTFE

NOTE
Flexible and Rigid probes require different radar electronics and can not be 
used with the same transmitter head.

Product Dielectric
For interface measurements the dielectric constant of the upper product is 
essential for calculating the interface level and the upper product thickness. 
By default the Product Dielectric parameter is about 2. 

If the dielectric constant of the lower product is significantly smaller than the 
dielectric constant of water, you may need to make special adjustments. See 
section “Interface Measurements for Semi-Transparent Bottom Products” on 
page 6-5 for further information.The dielectric constant of the product is used 
for setting the appropriate signal amplitude thresholds, see Section 6: Service 
and Troubleshooting for more information on amplitude threshold settings. 
Normally this parameter does not need to be changed for level 
measurements. However, for some products measurement performance can 
be optimized by setting the proper product dielectric constant.

The Rosemount Configuration Tool (RCT) software includes a Dielectric Chart 
which lists the dielectric constants of a wide range of products. RCT also 
includes a tool which allows you to calculate dielectric constants based on 
measurements of the Upper Product Thickness.

Vapor Dielectric
In some applications there is heavy vapor above the product surface having a 
significant influence on the level measurement. In such cases the vapor 
dielectric can be entered to compensate for this effect.

The default value is equal to 1 which corresponds to the dielectric constant of 
vacuum. Normally this value does not need to be changed since the effect on 
measurement performance is very small for most vapors.

HART Comm 1, 3, 2, 3

HART Comm 1, 3, 3, 3

HART Comm 1, 3, 3, 2
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Measurement Mode
Normally the Measurement Mode does not need to be changed. The 
transmitter is pre-configured according to the specified model:

Interface Immersed Probe is used for applications where the probe is fully 
immersed in liquid. In this mode the transmitter ignores the upper product 
level. See Section 6: Interface Measurements with Fully Immersed Probes for 
more information.

NOTE!
Only use Interface Immersed Probe for applications where interface is 
measured for a fully immersed probe.

Probe Angle
Enter the angle between the probe and the vertical line. The default value is 
equal to zero. Do not change this value if the transmitter is mounted with the 
probe along the vertical line (which is normally the case).

Maximum Upper Product 
Thickness For interface measurements the Maximum Upper Product Thickness 

parameter may be used in special cases when the dielectric constant of the 
upper product is relatively high. By setting this parameter you can avoid that 
interface measurements are getting out of range.

Damping
The default Damping value is 10. Normally this value does not need to be 
changed. The Damping parameter determines how quickly the transmitter 
responds to level changes and how robust the measurement signal is against 
noise. See “High Level Rates” on page 6-7 for more information.

Display Panel
Choose which variables to be displayed and the desired language to be used. 
The display toggles between the selected variables every two seconds.

HART Comm 1, 3, 3, 4

Table 4-1.  Measurement Mode
Model Measurement Mode
3301  Level(1), Interface Immersed probe

(1) Default setting

3302 Level, Level and Interface(1), Interface Immersed probe

HART Comm 1, 3, 2, 4

HART Comm 1, 4, 5, 2

HART Comm 1, 3, 5

HART Comm 1, 4, 2
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4 and 20 mA Points
When setting the range values, it is possible to enter the values directly using 
the keypad on the Field Communicator, or you may use actual values (HART 
command [1, 3, 4, 2]). Keep in mind that the 20 mA value should be below the 
Upper Dead Zone. If the 20 mA point is set to a point within the Dead Zone 
the full range of the analog output is not used.

Also make sure that the 20 mA value is below the Upper Null Zone (UNZ). 
(This parameter may be used if there are measurement problems in the upper 
part of the tank, see Section 6: Disturbances at the Top of the Tank). The UNZ 
is equal to zero in the default configuration.

The 4 mA point should be above the Lower Dead Zone. If the 4 mA point is 
set to a point within the Dead Zone or below the probe end (tank bottom for 
example), the full range of the analog output is not used.

See Section 2: Dead Zones for more information on the size of Upper and 
Lower Dead Zones.

Figure 4-7. Range Values

HART Comm 1, 3, 4, 3

20 mA Upper Range Value (URV)
Upper Dead Zone

Product Level

Interface Level

Lower Dead Zone

4 mA Lower Range Value 
(LRV)
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VOLUME 
CONFIGURATION

Transmitter Variables
Select the Volume option in order to configure the transmitter for volume 
measurements.

Volume Units
Choose one of the following units:

• Gallons
• Liters
• Imperial Gallons
• Cubic Meters
• Barrels
• Cubic Yards
• Cubic Feet
• Cubic Inch

Tank Type
Choose a standard tank shape, or select the strapping option. Standard 
shapes are: Vertical Cylinder, Horizontal Cylinder, Vertical Bullet, Horizontal 
Bullet or Sphere. (If Primary Variable is Level choose None for Tank Type).

If your tank does not correspond to any of the above tank shapes, select Strap 
Table.

Tank Dimensions
If a standard tank type was chosen, enter the diameter and height of the tank. 
See “Volume Configuration” on page 4-5 for information on how to specify 
tank dimensions.

Strapping Table
If tank type Strapping Table was chosen, enter how many entries you will use 
and the actual level and volume points. You can enter from 2 to 10 points. The 
strapping points must be entered such that the first point corresponds to the 
lowest level, and the last point corresponds to the topmost level of the tank.

HART Comm 1, 1, 1, 1

HART Comm 1, 3, 1, 2

HART Comm 1, 4, 3, 1

HART Comm 1, 4, 3, 2-3

HART Comm 1, 4, 3, 4
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CONFIGURATION USING 
THE RADAR 
CONFIGURATION TOOL

The Radar Configuration Tool (RCT) is a user-friendly software tool that 
allows you to configure the Rosemount 3300 transmitter. You can choose 
either of the following two methods to configure a 3300 transmitter: 

• Start the Wizard for a guided installation if you are unfamiliar with the 
Rosemount 3300.

• Use the Setup function if you are already familiar with the configuration 
process or if you just want to change the current settings.

Installing the RCT 
software

To install the Rosemount Configuration Tool:

1. Insert the installation CD into your CD-ROM drive.
2. If the installation program is not automatically started, from the windows 

Start Bar choose Run and type D:\Setup.exe where D is the CD-ROM 
drive.

3. Follow the instructions on the screen.
4. For optimum performance set COM Port Buffers to 1, see “To set the 

COM port buffers” on page 4-26.

To start the RCT:

1. From the Start menu click Programs>RCT Tools>RCT.
2. In the RCT Status Bar check that RCT communicates with the 

transmitter:

Specifying the COM Port If communication is not established open the HART Communication Server 
window and check that the right COM Port is selected.

To check the current COM port settings do the following:

1. Locate the HART Server icon in the lower right corner of the screen.

2. Double-click the HART Server icon.

Communication is established (green symbol)

Communication is not established (red symbol)

HART Server icon
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Figure 4-8. RHCS Server 
window

3. Check the COM port.
4. Choose the COM Port option that matches the COM Port connected to 

the transmitter.
5. If communication is intermittent, increase Busy Retries and Error Retries 

to 5 and 5 respectively.
6. Click the Search for a device icon in the RCT tool bar:

Help In RCT Help is accessed by pressing the F1 key or by selecting the Contents option 
from the Help menu. If the F1 key is pressed a help text appears with 
information about the window that is currently open. If a menu option is 
selected a help text appears with information about that particular menu.

Check that the selected 
COM port matches the 
connected port on the PC.
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Using the Setup Wizard To install a 3300 transmitter by using the installation Wizard do the following:

Figure 4-9. RCT workspace

Figure 4-10. RCT Wizard

1. Start the RCT software.
2. In the RCT workspace click the 

Wizard icon (make sure that the 
Basic section is open),
or
choose the View>Wizard menu 
option.

Basic

Wizard

R
C

T1

3. Click the Start button and follow the 
instructions. Now you will be guided 
through a number of dialogs 
allowing you to configure the 
transmitter. 
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Using the Setup 
Function

To install a 3300 transmitter by using the Setup function do the following:

Figure 4-11. RCT workspace

Figure 4-12. Setup Info

NOTE
When working with the Setup window keep in mind that for all tabs except the 
Info tab, data is updated by clicking the Receive button. To download data to 
the transmitter click the Send button.

1. Start the RCT software.
2. In the RCT workspace click the 

Setup icon (make sure that the 
Basic area is open),
or
choose the View>Setup menu 
option.

Setup

Basic
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3. Choose the appropriate tab:

Info: information about the device.

Basics: Set Probe Type and 
measurement units.

Analog: Variable assignment and 
range value settings.

Tank Config: Tank height and other 
geometry settings, dielectric 
constants for vapor and upper 
product.

Volume: specification of tank 
geometry for volume calculations.

LCD: display panel settings.
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Setup - Info The Title tab shows information about the connected transmitter.

Figure 4-13. Setup Title tab

Device Name: designation of the current transmitter model.

EPROM ID:current transmitter database version.

Device Type: designates the transmitter type. 33 is used for the 
Rosemount 3300.

Device ID: a unique identifier for each Rosemount 3300 Series transmitter.

Hardware Rev: the current revision of the transmitter electronic board.

Software Rev: the current revision of the transmitter software that controls 
measurement, communication, internal checks etc. 

Setup - Basics The Basics tab lets you choose Measurement Units for Level, Volume and 
Temperature. These units are used wherever measurement and configuration 
data is presented.

Figure 4-14. Setup Basic tab

This window also allows you to enter some general information about the 
transmitter like Message, Tag, Descriptor and Date. This information is not 
required for the operation of the transmitter and can be left out if desired.
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Setup - Output The Output tab lets you assign up to four transmitter variables.

Figure 4-15. Setup output tab

Typically, the Primary Variable (PV) is configured to be Product Level, 
Interface Level or Volume.

Other variables like Product Distance, Interface Distance, Upper Product 
Thickness, etc. are available as well.

For the Rosemount 3301 the primary variable is typically set to be Level. If the 
transmitter is in the Immersed Probe mode (see section 
Measurement Mode) the PV is normally set to Interface Level.

For the Rosemount 3302 the PV is typically set to Interface Level, but Level 
and other options may also be used.

Set the Lower Range Value (4 mA) and the Upper Range Value (20 mA) to 
the desired values. Keep in mind that the 20 mA value should be below the 
Upper Dead Zone, and the 4 mA point should be above the Lower Dead Zone 
if you want to use the full 4-20 mA range within the measuring range of the 
transmitter.

Also make sure that the 20 mA value is set below the Upper Null Zone (UNZ). 
(the UNZ parameter may be used if there are measurement problems in the 
upper part of the tank, see Section 6: Disturbances at the Top of the Tank). 
The UNZ is equal to zero in the default configuration.

See Section 2: Dead Zones for more information on Upper and Lower Dead 
Zones. 

See Section 4: Basic Configuration for more information on setting the Upper 
and Lower Range values.

The default Damping value is 10. Normally this value does not need to be 
changed. The Damping parameter may be changed if there are high filling 
rates, see “High Level Rates” on page 6-7 for more information.
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Setup - Tank Config The Tank Configuration tab contains information on tank geometry 
parameters and dielectrics.

Figure 4-16. Setup Tank 
Configuration tab

Tank Geometry

The Reference Gauge Height is the distance from the Upper Reference 
Point to the bottom of the tank (see Figure 4-1 on page 4-2). When setting the 
Reference Gauge Height, keep in mind that this value is used for all level and 
volume measurements performed by the 3300 transmitter. 

The Reference Gauge Height must be set in linear (level) units, such as feet 
or meters, regardless of primary variable assignment.

The Upper Null Zone (UNZ) should not be changed unless there are 
disturbances at the top of the tank. By increasing the Upper Null Zone value 
measurements in this region can be avoided. See Section 6: Disturbances at 
the Top of the Tank for more information on how to use the UNZ. The UNZ is 
equal to zero in the factory configuration.

Probe

The 3300 Series transmitter automatically makes some initial calibrations 
based on the chosen Probe Type. The following Probe Types are available:

• Rigid Twin
• Flexible Twin
• Coaxial, Coaxial HP, Coaxial HTHP
• Rigid Single, Rigid Single HTHP, Rigid Single PTFE
• Flexible Single, Flexible Single HTHP, Flexible Single PTFE

NOTE
Flexible and Rigid probes require different radar electronics and can not be 
used with the same transmitter head

The Probe Length is the distance from the Upper Reference Point to the end 
of the probe, see Figure 4-1. If the probe is anchored to a weight do not 
include the height of the weight.

The Probe Angle is the angle between the probe and the vertical line. Set 
this value equal to zero if the transmitter is mounted with the probe along the 
vertical line (which is normally the case).
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Measurement Mode

Normally the Measurement Mode does not need to be changed. The 
transmitter is pre-configured according to the specified model:

Interface Immersed Probe is used for applications where the probe is fully 
immersed in liquid. In this mode the transmitter ignores the upper product 
level. See “Section 6: Interface Measurements with Fully Immersed Probes” 
for more information.

NOTE!
Only use Interface Immersed Probe for applications where interface is 
measured for a fully immersed probe.

Dielectrics

In some applications there is heavy vapor above the product surface having a 
significant influence on the level measurement. In such cases the Vapor 
Dielectric can be entered to compensate for this effect.

The default value is equal to 1 which corresponds to the dielectric constant of 
vacuum. Normally this value does not need to be changed since the effect on 
measurement performance is very small for most vapors.

For interface measurements the dielectric constant of the upper product is 
essential for calculating interface level and the upper product thickness. By 
default the Upper Product Dielectric parameter is about 2. 

If the dielectric constant of the lower product is significantly smaller than the 
dielectric constant of water, you may need to make special adjustments. See 
section “Interface Measurements for Semi-Transparent Bottom Products” on 
page 6-5 for further information.

The dielectric constant of the product is used for setting the appropriate signal 
amplitude thresholds, see Section 6: Service and Troubleshooting for more 
information on amplitude threshold settings. Normally this parameter does not 
need to be changed for level measurements. However, for some products 
measurement performance can be optimized by setting the proper product 
dielectric constant.

RCT contains tools to estimate the dielectric constant of the current product:
• The Dielectric Chart lists the dielectric constant of a large number of 

products. Use one of the two following methods to view the Dielectric 
Chart:
- Choose the View>Dielectric>Dielectric Chart menu option. 
- Click the Dielectric Chart icon in the Project Bar Advanced section.

• The Dielectric Calculator lets you calculate the dielectric constant of 
the Upper Product based on the following input:
- actual upper product thickness,
- the dielectric constant value stored in the transmitter, and
- the upper product thickness presented by the transmitter.

Table 4-2.  Measurement Mode
Model Measurement Mode
3301  Level(1), Interface Immersed probe

(1) Default setting

3302 Level, Level and Interface(1), Interface Immersed probe
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Measurements Below Probe End

The Present Level=0... check box controls how the level value is presented 
when the tank is almost empty. By selecting this check box the Level is set 
equal to zero as long as the product surface is below the probe. 

If the check box is not selected, the Level value is equal to the difference 
between Reference Gauge Height R and Probe Length L when the product 
surface is below the probe (see “Basic Configuration” on page 4-2 for 
information on tank geometry). 

Setup - Volume The Volume tab lets you configure the transmitter for volume calculations.

Figure 4-17. Setup Volume tab

You can choose one of the standard tank shapes or the strapping option. 
Choose None if volume calculation is not used at all.

Choose one of the following options:
• Vertical Cylinder
• Horizontal Cylinder
• Vertical Bullet
• Horizontal Bullet
• Sphere
• Strap table
• None

See Section 4: Volume Configuration for more information on Volume 
configuration.
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Setup - LCD The LCD tab lets you specify which parameters to appear on the display 
panel. The display has two rows, the upper row with five characters is for the 
measured value and the lower row with six characters for the value name. 
The display toggles between the different variables every 2 seconds.

Figure 4-18. Setup LCD tab

Choose one of the following options:

Table 4-3.  LCD parameters
Parameter Description

Level Product level.

Distance Distance from the upper reference point to the product surface.

Volume Total product volume.

Internal Temperature Temperature inside the transmitter housing.

Interface Distance Distance between the upper reference point and the interface 
between the upper and lower product.

Interface Level Level of the lower product.

Interface Thickness Thickness of the upper product.

Amplitude Peak 1 Signal amplitude of the reflected signal from the reference pulse.

Amplitude Peak 2 Signal amplitude of the reflected signal from the product surface.

Amplitude Peak 3 Signal amplitude of the reflected signal from the surface of the 
bottom product (interface measurements).

Percent Range Level value in percent of total measurement range.

Analog Output Current 4 -20 mA current.
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SPECIAL FUNCTIONS

TriLoop The Rosemount 333 HART Tri-Loop HART-to-Analog Signal Converter is 
capable of converting a digital HART burst signal into three additional 4-20 
mA analog signals. 

To set the Rosemount 3300 transmitter up for the HART Tri-Loop do the 
following:

1. Make sure that the 3300 transmitter is properly configured.
2. If RCT is used for the 3300 setup, it is recommended that the Receive 

Buffer and Transfer Buffer for the selected COM port are adjusted as 
described below in section “To set the COM port buffers.” Otherwise the 
Burst Mode can not be turned off by RCT (for further information on other 
options for turning off the Burst Mode see “To turn off the Burst Mode.”

3. Assign transmitter variables Primary Variable, Secondary Variable etc.
HART command [1,1,1,1].
RCT: Setup>Output tab.

4. Configure variable units: Length, Volume and Temperature. 
HART command [1,3,2,1-3].
RCT: Setup>Basics tab.

Variables 
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5. Set the 3300 in Burst mode.
HART command [1, 4, 5, 2, 3].
RCT: Device Commands>Details>Set Burst Mode option.

6. Select Burst option 3=Process variables and current (Process vars/crnt).
HART command [1,4,5,2,4].

7. Install the Tri-Loop. Connect Channel 1 wires, and optionally wires for 
Channel 2 and Channel 3.

8. Configure Tri-Loop Channel 1:
a. Assign variable: Tri-Loop HART command [1,2,2,1,1].

Make sure that the SV, TV, and QV match the configuration of the 
3300 transmitter.

b. Assign units: Tri-Loop HART command [1,2,2,1,2]. Make sure that 
the same units are used as for the 3300 transmitter.

c. Set the Upper Range Value and the Lower Range Value: Tri-Loop 
HART command [1,2,2,1,3-4].

d. Enable the channel. Tri-Loop HART command [1,2,2,1,5].
9. (Optional) Repeat steps a-d for Channels 2 and 3.

10. Connect wires to Tri-Loop Burst Input.
11. Enter the desired tag, descriptor and message information:

Tri-Loop HART command [1,2,3].
12. (Optional) If necessary, perform an analog output trim for Channel 1 (and 

Channel 2 and 3 if they are used).
Tri-Loop HART command [1,1,4].

Figure 4-19. Tri-Loop wiring.

See the reference manual for the Model 333 HART Tri-Loop HART-to-Analog 
Signal Converter for further information on how to install and configure the 
Tri-Loop.
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from Control 
Room
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To turn off the Burst Mode

In order to turn off the Burst Mode use one of the following options:
• The RCT program (requires that the Receive and Transfer Buffers for 

the selected COM Port is adjusted)
• The Rosemount Burst Mode Switch software
• A 375 Field Communicator
• The AMS software

To set the COM port buffers

In order to be able to communicate with the 3300 in Burst Mode the Receive 
and Transfer Buffers need to be adjusted as follows:

1. In the MS Windows Control Panel open the System option.
2. Choose the Hardware tab and click the Device Manager button.
3. Expand the Ports node in the tree view.
4. Click the right mouse button on the selected COM port and choose 

Properties.
5. Select the Port Settings tab and click the Advanced button.
6. Drag the Receive Buffer and Transfer Buffer slides to 1.
7. Click the OK button.
8. Reboot the computer.
4-26
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Section 5 Operating the Display Panel
Display Functionality  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 5-1
Error Messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 5-2

DISPLAY 
FUNCTIONALITY

The Rosemount 3300 transmitter uses the display for presentation of 
measurement variables. The display has two rows, the upper row with five 
characters is for the measured value and the lower row with six characters for 
the value name and measurement unit. The display toggles between the 
different variables every 2 seconds. Variables to be presented are 
configurable by using a Field Communicator or by using the Radar 
Configuration Tools software.

Figure 5-1. Presentation of 
measurement data

Model 3300 can display the following variables:
• Level
• Distance
• Volume
• Internal Temperature
• Interface Distance
• Interface Level
• Amplitude 1, 2 and 3 (see chapter 6 for more information)
• Interface Thickness
• Percent of range
• Analog current out

Measurement value

Measurement unit
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ERROR MESSAGES The display can also be used for presentation of software errors. The upper 
row shows error codes and the lower row shows 'ERROR'.

Figure 5-2. Presentation of error 
messages 

The following errors can be displayed:

See also “Errors” on page 6-22.

ALARM AND WRITE 
PROTECTION

When mounting the Integral Display panel it is important that the Alarm and 
Write Protection switches on the transmitter mother board are correctly set. 
Make sure that the Alarm switch is in the HIGH position and the Write 
Protection switch is in the OFF position, see Figure 5-3. See also Section 3: 
Before You Install for more information.

Figure 5-3. Alarm and Write 
Protection switches.

Once the mother board positions are set, then the display positions become 
the master.

Code Error

CNFIG Invalid Configuration

00001 Ram Failure

00002 ROM Checksum

00006 Waveform Acquisition Failure

00007 EEprom Factory Checksum

00008 EEprom User Checksum

00010 Software Error

00013 Probe Failure

Error code

“ERROR”
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Section 6 Service and Troubleshooting
Safety messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 6-1
Advanced Configuration  . . . . . . . . . . . . . . . . . . . . . . . . . . page 6-2
Service . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 6-9
Diagnostic Messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 6-21

SAFETY MESSAGES Procedures and instructions in this section may require special precautions to 
ensure the safety of the personnel performing the operations. Information that 
raises potential safety issues is indicated by a warning symbol ( ). Please 
refer to the following safety messages before performing an operation 
preceded by this symbol.
.

Explosions could result in death or serious injury.
Verify that the operating environment of the gauge is consistent with the appropriate 
hazardous locations certifications.

Before connecting a HART-based communicator in an explosive atmosphere, make 
sure the instruments in the loop are installed in accordance with intrinsically safe or 
non-incendive field wiring practices.

Do not remove the gauge cover in explosive atmospheres when the circuit is alive.

Failure to follow safe installation and servicing guidelines could result in death or 
serious injury.
Make sure only qualified personnel perform the installation.

Use the equipment only as specified in this manual. Failure to do so may impair the 
protection provided by the equipment.

Do not perform any service other than those contained in this manual unless you are 
qualified.

High voltage that may be present on leads could cause electrical shock.
Avoid contact with leads and terminals. 

Make sure the main power to the Rosemount 3300 Transmitter is off and the lines to any 
other external power source are disconnected or not powered while wiring
the gauge.

Probes covered with plastic and/or with plastic discs may generate an ignition-capable 
level of electrostatic charge under certain extreme conditions. Therefore, when the 
probe is used in a potentially explosive atmosphere, appropriate measures must be 
taken to prevent electrostatic discharge.

Process leaks could result in death or serious injury.
Make sure that the transmitter is handled carefully. If the Process Seal is damaged, gas 
might escape from the tank if the transmitter head is removed from the probe.
www.rosemount.com
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ADVANCED 
CONFIGURATION

This section covers non-standard configuration.

User defined Upper 
Reference Point

If you want to specify your own Upper Reference Point you can do this by 
setting the Calibration Offset parameter. 

Figure 6-1. Tank Geometry

To set the desired upper reference point do the following:

1. Adjust the Reference Gauge Height to the distance from the tank 
bottom to the desired Upper Reference Point.

2. Add the distance between the Upper Reference Point and the 
Transmitter Reference Point to the Calibration Offset value that is 
stored in the transmitter database. 
With the HART Communicator the Calibration Offset is available as 
HART Fast Key sequence [1, 4, 5, 5].
In Radar Configuration Tool (RCT) the Calibration Offset is available 
under the Advanced section in the RCT Project Bar:
Device Commands>Basic>Set Calibration Offset.

Reference Gauge 
Height

Product Level

Upper Reference Point
Transmitter 
Reference Point

Calibration 
Offset
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Plotting the 
Measurement Signal

The Radar Configuration Tool (RCT) has powerful tools for advanced 
troubleshooting. By using the Waveform Plot function you get an instant view 
of the tank signal. Measurement problems can be solved by studying the 
position and amplitude of the different pulses.

To plot the measurement signal:

1. Start the Radar Configuration Tool program.
2. Choose the View>Plotting menu option, or choose the Plotting icon in 

the RCT workspace (Advanced page at the left side of the workspace) 
and click the Read button.

Figure 6-2. Waveform plot in RCT

In a typical measurement situation the following pulses appear in the diagram:

P1 - Reference pulse. This pulse is caused by the transition between 
transmitter head and probe. It is used by the transmitter as a reference at 
level measurements.

P2 - Product surface. This pulse is caused by a reflection on the product 
surface. In Measurement Mode=Interface when Immersed Probe however, P2 
indicates the interface since the surface of the upper product is ignored.

P3 - Interface or probe end. This pulse is caused by reflection on the interface 
between an upper product and a bottom product with a relatively high 
dielectric constant. It may also be caused by the probe end if there is no 
product above. This pulse is shown when the transmitter is in Measurement 
Mode=Level & Interface.

Different amplitude thresholds are used in order to filter out unwanted signals. 
The following amplitude thresholds are used for the 3300 transmitter:

T1 - amplitude threshold for detection of the Reference pulse P1.

T2 - amplitude threshold for detection of the product level peak P2.

T3 - amplitude threshold for detection of the interface level peak P3.

T4 - amplitude threshold that is used to detect whether the probe is fully 
immersed in the upper product or not.

Normally the thresholds are adjusted to approximately 50% of the signal peak 
amplitude. To adjust the Amplitude Thresholds open the Advanced section 
in the RCT Project Bar and choose Device Commands>Details>Set Nominal 
Thresholds. To reset the default values set Amplitude Threshold=0 (zero).

Upper Null Zone
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Logging and saving to disk

The Waveform plot can be automatically logged and saved to file by 
specifying the read plot interval and the number of plots to log.

Figure 6-3. Disk logging 
Waveform plot

The Read Plot Interval entry field specifies the time interval between plots 
that are saved to disk. For example, type 10 if you want the waveform plot to 
be updated every ten minutes.

Number of plots to log specifies the maximum number of plot files that will 
be stored. The default value is 100.

Click the Start Disk Logging button to start the log. Make sure that Read 
Action type is set to Multiple Read. Otherwise RCT will only save one log file. 
Choose a destination folder and enter a file name. For each new file the 
corresponding number is appended to the end of the file name.

Start disk logging

Start monitoring

Number of plots

Read plot interval
Read action type
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Interface Measurements 
for Semi-Transparent 
Bottom Products

In interface applications where the bottom product has a low dielectric 
constant, or if the signal is attenuated in the upper product, the amplitude of 
the reflected signal is relatively low and difficult for the transmitter to detect. In 
such a case it may be possible to detect the reflected signal if the 
corresponding amplitude threshold is adjusted.

The Radar Configuration Tool (RCT) lets you view a waveform plot to analyze 
the measurement signal. The plot shows the signal and the thresholds used 
for the different amplitude peaks. By adjusting amplitude threshold T3 it is 
possible to detect even weak interface signals. 

Guidelines for amplitude threshold settings:
• The amplitude threshold T3 should be approximately 50 % of the 

interface signal amplitude.
• Threshold T3 should not be less than 3.
• If possible, T3 should be higher than T2.

You can use the RCT software or a 375 Field Communicator to change the 
amplitude thresholds. For the Field Communicator use the HART command 
[1, 4, 5, 3]. See also “Amplitude Threshold Settings” on page 6-13.

RCT lets you view a plot of the measurement signal along with the current 
thresholds:

1. From the View menu choose the Plotting option, or double-click the 
Plotting icon in the Advanced section of the RCT Project Bar. 

2. Click the Read button .
3. To adjust the Amplitude Thresholds open the Advanced section in the 

RCT Project Bar and choose Device Commands>Details>Set Nominal 
Thresholds.

Figure 6-4. Waveform plot 
indicating that the amplitude 
threshold for the interface peak 
is too high.

The amplitude threshold is above 
the measurement signal peak
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Figure 6-4 illustrates a situation where amplitude threshold T3 is too high. The 
signal amplitude peak at the interface between the upper and lower products 
is not detected in this case. By adjusting amplitude threshold T3, the peak at 
the interface between the upper and lower products is detected as illustrated 
in Figure 6-5:

Figure 6-5. After changing the 
amplitude threshold the 
transmitter detects the interface

The amplitude threshold is 
adjusted below the peak to allow 
the interface peak to be detected
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High Level Rates The measurement signal is filtered in order to minimize the influence of 
disturbing noise. In most measurement situations this does not have a 
noticeable effect on the response time to level changes. If high level rates 
occur it may however be necessary to reduce the damping value in order to 
allow the transmitter to respond quicker. If there is too much noise the 
damping value may be increased in order to get a stable measurement signal.

You can use the RCT software or a 375 Field Communicator to change the 
Damping value. For the HART Communicator use the key sequence 
[1, 3, 5]. 

In the RCT software open the Setup>Output tab and enter the desired 
Damping value:

The Damping parameter determines how quickly the transmitter responds to 
level changes and how robust the measurement signal is against noise. 
Technically, a damping value of 10 means that in 10 seconds the output from 
the transmitter is about 63% of the new level value. Consequently, when there 
are rapid level changes in the tank, it may be necessary to decrease the 
Damping value for the transmitter to be able to track the surface. On the other 
hand, in noisy environments, and if level rates are low, it may be better to 
increase the damping value to have a stable output signal.

Damping

Output tab
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Interface Measurements 
with Fully Immersed 
Probes

The 3300 series has a measurement option which makes it possible to handle 
interface measurements when the product level is not visible, for example in a 
full bridle pipe as illustrated in Figure 6-6. In this case the probe is fully 
immersed into the upper product, and only the interface level is detected by 
the transmitter. Even if the upper product level drops, it is ignored by the 
transmitter which continues to measure only the interface level, but the 
measurement accuracy is reduced since the transmitter does not take into 
account the influence of the air gap above the product surface. 

The Measurement Mode parameter is available via the 
HART command [1, 3, 3, 4]. Choose the Interface when Immersed Probe 
option.

Measurement mode Interface when Immersed Probe can also be activated in 
the RCT software:

1. Open the Setup window.
2. Select the Tank Config tab.
3. Choose Measurement Mode Interface when Immersed Probe.
4. Click the Send Page button.

NOTE!
Do not use Measurement Mode Interface when Immersed Probe in “standard” 
applications when both Interface Level and Product Level are measured.

If the product level drops, the air filled region in the upper part of the pipe will 
slightly reduce the measurement accuracy of the interface level. To achieve 
high accuracy in this measuement mode the probe must be fully immersed.

Figure 6-6. Interface Level 
measurements in a full bridle 
pipe.

NOTE!
Adjust Threshold T2 if the level pulse is not detected.
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SERVICE

Analog Output 
Calibration

To calibrate the Analog Output current do the following:

1. Start RCT and make sure that the transmitter communicates with the PC 
(see Section 4: Installing the RCT software).

2. Open the Advanced section in the RCT workspace Project Bar and click 
the Device Commands icon,
or
choose the Device Commands option from the View menu.

3. Open the folder named Diag and double-click the Fixed Current Mode 
option.

4. Set the output current to 4 mA.

5. Measure the output current.
6. Open the folder named Details.
7. Choose the Trim DAC Zero option and enter the measured output 

current.
8. In the Diag folder double-click the Fixed Current Mode option and set the 

output current to 20 mA.
9. Measure the output current.

10. In the Details folder double-click the Trim DAC Gain option and enter the 
measured output current.

11. In the Diag folder double-click the Fixed Current Mode option and set the 
output current to 0 mA in order to leave the Fixed Current mode.

Fixed Current 
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Level and Distance 
Calibration

When calibrating the transmitter it is important that the product surface is calm 
and that the tank is not being filled or emptied.

A complete calibration is performed in two steps:

1. Calibrate the Distance measurement by adjusting the Calibration Offset 
parameter.

2. Calibrate the Level measurement by adjusting the Reference Gauge 
Height.

Distance calibration

1. Measure the actual distance between the Upper Reference Point and the 
product surface.

2. Adjust the Calibration Offset so that the Distance measured by the 
transmitter corresponds to the actual distance. 
The Calibration Offset parameter is available via 
HART command [1, 4, 5, 5],
or
RCT: open the Advanced section in the Project Bar and choose Device 
Commands>Basics>Set Calibration Offset.

Level calibration

1. Measure the actual Product Level.
2. Adjust the Reference Gauge Height so that the measured Product Level 

corresponds with the actual level.

Figure 6-7. Distance and Level 
calibration
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Disturbances at the Top 
of the Tank

Using the Trim Near Zone Function

For transmitters using the Guided Wave Radar technology the performance In 
the Near Zone (referred to as the region between 0-1.6 ft (0-0.5 m) below the 
Upper Reference Point) is normally somewhat limited. However, the 3300 
transmitter is equipped with software functionality that minimizes the Upper 
Dead Zone. The factory setting is normally sufficient and doesn’t need to be 
repeated after installation. 

However, since the setting is optimized depending on actual installation, 
further trimming may be necessary in the case of unfavorable conditions. This 
may for example be the case if a Single Lead probe is mounted in a small 
nozzle, or if there are disturbing obstacles in the Near Zone. The trimming 
means that the measurement performance in the Near Zone is maintained 
even under these conditions and prevents false echo indication.

To trim the Near Zone perfomance do the following:

1. Make sure that the product level is below the Near Zone region 
(0-1.6 ft (0-0.5 m) below the Upper Reference Point).

2. Start the Radar Configuration Tools (RCT).
3. Choose the Device Commands option from the View menu.
4. Open the Details folder.
5. Click the Trim Near Zone option.
6. Select the Update option and click the OK button.

NOTE!
The Trim Near Zone function should only be used for reducing impact from 
constant disturbances. It is not suitable for occasional disturbances.

To reset the transmitter to factory settings do the following:

1. Start the Radar Configuration Tools (RCT).
2. Choose the Device Commands option from the View menu.
3. Open the Details folder.
4. Click the Trim Near Zone option.
5. Select the Reset to Factory Settings option and click the OK button.

Changing the Upper Null Zone

Measurements are not performed within the Upper Null Zone (UNZ). By 
setting the UNZ parameter to zero, measurements can be performed in the 
region close to the flange (Near Zone). However, it is very important that there 
are no disturbances in that region if UNZ is set to zero.

If there are measurement problems in the upper part of the tank you may use 
the Trim Near Zone function as described above.

If the desired measurement range is below the Near Zone, or if disturbing 
objects are located below the Near Zone, the Upper Null Zone parameter can 
be used to avoid measurements above a certain level. 
6-11
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To set the Upper Null Zone do one of the following:

1. Select the HART command [1, 3, 3, 1].
2. Enter the desired value, 

or

1. Start the Radar Configuration Tool (RCT).
2. Click the Setup icon in the RCT workspace Project Bar.
3. Choose the Tank Config tab in the Setup window.
4. Click the Receive Page button.
5. Type the desired value in the Upper Null Zone field.
6. Click the Send Page button. Now the Upper Null Zone is stored in the 

transmitter memory.

Figure 6-8. Upper Null Zone

Figure 6-9. Identifying the Upper 
Null Zone in the RCT Waveform 
Plot
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Amplitude Threshold 
Settings

The amplitude thresholds are automatically adjusted to appropriate values in 
order to filter out noise and other non-valid measurements from the 
measurement signal.

The amplitude of the measurement signal, i.e. the amplitude of the signal that 
is reflected by the product surface, is related to the actual dielectric constant 
of the product. The amplitude threshold that is used by the transmitter is 
based on the parameter configuration of the current product dielectric 
constant (see Section 4: Basic Configuration). Normally no other threshold 
adjustment is needed, but if the transmitter still does not track the product 
surface correctly it may be necessary to adjust the threshold values.

The Radar Configuration Tool (RCT) has a plot function allowing you to view 
the reflections along the probe.

If the amplitude threshold is too high the product level is not detected as 
illustrated in Figure 6-10.

Figure 6-10. Example 1: 
amplitude threshold T2 is too 
high.

If there are disturbing objects in the tank the threshold must be carefully set in 
order to avoid locking on the wrong amplitude peak. In Figure 6-11 the 
transmitter has locked on a peak above the actual product surface, i.e. a 
disturbance was interpreted as the product surface, whereas the actual 
product surface was interpreted as an interface or the probe end. 

Figure 6-11. Example 2: 
amplitude threshold T2 is too 
low.
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By adjusting the amplitude threshold T2 the product surface is detected 
correctly as illustrated in Figure 6-12.

Figure 6-12. Waveform plot after 
threshold T2 was adjusted 

To adjust the amplitude thresholds select HART command [1, 4, 5, 3] 

or

1. Start the Radar Configuration Tool (RCT).
2. Choose the Device Commands option from the View menu.
3. Open the Details folder.
4. Click the Set Nominal Thresholds option.

The thresholds T2 and T3 should be set to about 50% of the measured signal 
amplitude for the product surface and the interface peaks, respectively. 

NOTE
Amplitude thresholds should not be set to values less than 3.

NOTE
Check that the dielectric constant parameter setting is reasonably close to the 
actual dielectric constant value of the upper product before changing the 
amplitude thresholds.

NOTE
Default Amplitude thresholds can be set by typing 0 as the new threshold 
value.
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Using the 375 Field Communicator

To adjust amplitude threshold value:

1. Select HART command [1, 4, 5, 3].
The different amplitude thresholds appear on the display.

2. Open the desired amplitude threshold for editing.

3. Type the desired threshold value and click the ENTER button.
4. Click the SAVE button to store the new value in the transmitter database.
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Logging Measurement 
Data

To start logging do the following:

1. Click the Monitor icon in the RCT workspace or choose the Monitor 
option from the View menu.

2. Choose the desired variables to be monitored and click the Start Monitor

button.

Saving the log to disk

1. Choose the desired variables to be monitored.
2. Click the Log interval button and enter a time interval. For example, 

type 10 if you want data to be logged every tenth second.
3. Click the Counter button and enter the maximum number of files to be 

stored. The Counter is used to limit the amount of data stored on the 
hard disk. Each time the maximum number of entries in a log file is 
reached, the current log file is saved and a new file is created. This 
procedure continues up to the maximum number of files given by the 
Counter value. The file size is limited to 60,000 entries which can easily 
be handled by spreadsheet programs like MS Excel.

4. Select the desired options for Timer, Time and Date. By selecting a 
check box the corresponding time indication is stored for each log entry 
in the log file.

5. Click the Start disk logging button.

6. Choose a destination folder and enter a file name.

Start disk logging

Start monitoring CounterLog interval
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Saving the Transmitter 
Configuration

The Radar Configuration Tool offers different methods to save the current 
transmitter configuration:

• Save only the configuration specified in the Setup window. 
• Use the more extensive function in the Memory Map window.

You can use a stored configuration file as a backup of the current 
configuration, or it can be distributed for service purposes.

To save the current transmitter setup do the following:

1. Click the Setup icon in the RCT workspace or choose the Setup option 
from the View menu to open the Setup window.

2. Click the right mouse button and choose the Receive All option,
or
from the Setup menu choose the Receive All option.
Alternatively, you can use the Receive Page option on each individual 
page.

NOTE!
All pages must be received before the setup can be saved. 

3. Click the right mouse button and choose the Save Setup option.

4. Choose a destination folder and enter a file name.
5. Click the Save button.

Save Setup
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To load a setup

1. Click the Setup icon in the RCT workspace or choose the Setup option 
from the File menu.

2. In the Setup window click the right mouse button and choose the Open 
Setup option, or
from the File menu choose the Open Setup option.

3. Open the source folder and select the desired setup file.
4. Click the Open button.

Memory Map

The Memory Map window lets you view the current transmitter database 
registers. It is also possible to save the current database for backup or service 
purposes, and it is also possible to download a backup database to the 
transmitter. To save configuration data in the Memory Map window:

1. Start the RCT program.
2. Choose the View>Memory option, or click the Memory Map icon in the 

RCT workspace (Advanced section at the left side of the workspace 
window).

3. Choose the All EE option from the drop-down list.
4. Click the Receive button. (It may take a few minutes to read the 

database).
5. Click the right mouse button and choose the Save Memory As option.
6. Type the desired file name and click the OK button. Now the current 

database is stored.

See the Online Help in RCT for further information on how to open a saved 
database and how to download a database to the transmitter.

Open Setup

R
C

T-
SE

TU
P

_B
A

S
IC

S
_S

A
V

ES
E

TU
P

6-18

Rick Hurdle
Highlight



Reference Manual 
00809-0100-4811, Rev CA
February 2006 Rosemount 3300 Series
Removing the 
Transmitter Head

1. Loosen the nut that connects the 
transmitter housing to the Process Seal.

2. Carefully lift the transmitter head.
3. Make sure that the upper surface of the 

Process Seal is clean and the 
spring-loaded pin at the center of the 
Process Seal is properly inserted (the pin 
should move back when pushed into the 
hole).

4. Attach the protection plug to the Process 
Seal. 

Nut

Process SealPut the protection 
plug here!
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Changing the Probe

1. Loosen the nut.
2. Remove the transmitter head from the old probe.
3. On the new probe, make sure that the protection plug is removed and the 

upper surface of the Process Seal is clean. Also make sure that the 
spring-loaded pin at the center of the Process Seal is properly inserted.

4. Mount the transmitter head on the new probe.
5. Fasten the nut again.
6. If the new probe is not of the same type as the old one, update the 

transmitter configuration by setting the Probe Type parameter to the 
appropriate value: 
HART Fast Key sequence [1, 3, 2, 3],
or
RCT Setup/Tank Config.

7. Measure the probe length and enter the measured value:
HART Fast Key sequence [1, 3, 2, 2],
or
RCT Setup/Tank Config.

8. Verify that the transmitter is calibrated.

NOTE
Flexible and Rigid probes require different radar electronics and can not be 
used with the same transmitter head.
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DIAGNOSTIC 
MESSAGES

Troubleshooting If there is a malfunction despite the absence of diagnostic messages, see 
Table 6-1 for information on possible causes.

Table 6-1.  Troubleshooting 
chart

Symptom Possible cause Action
No HART communication. • COM Port configuration does not match 

the connected COM Port.
• Cables may be disconnected.
• Wrong HART address is used.
• Hardware failure.

• Check that correct COM Port is 
selected in the HART server (see 
“Specifying the COM Port” on 
page 4-14.

• Check wiring diagram.
• Verify that the 250 Ohm resistor is in 

the loop.
• Check cables.
• Make sure that correct HART short 

address is used. Try address=0.
• Check Analog Output current value to 

verify that transmitter hardware works.

Analog Out is set in Alarm. Use the command “Read Gauge Status” 
in order to check active errors.

Both P2 and P3 are detected but Interface 
Level is reported as Not A Number (NAN) 
in the waveform plot.

Measurement Mode is set to “Level Only”. Set Measurement Mode to “Level and 
Interface” (see “Basic Configuration” on 
page 4-9).

Both Level and Interface Level are 
reported as NAN.

Probe is not connected. Use the command “Read Gauge Status” 
and check if error “Probe Failure” is 
active. If this is the case, check the probe 
connection.

Both P2 and P3 are detected but the 
interface level is equal to the product 
Level.

• P3 is identified as a double bounce.
• P2 and P3 are very close.

Adjust thresholds T2 and T3, see 
“Amplitude Threshold Settings” on 
page 6-13 for more information.

P2 is detected but Level is incorrectly 
reported as Full or Empty.

Use the command “Read Gauge Status” 
and check if the warning “Probe 
Immersed” is active. If this is the case 
check that:

• the transmitter is configured with 
correct probe type,

• the reference pulse (P1) is below 
amplitude threshold T4. If not, adjust 
T4 to an appropriate value.

The reference pulse is not detected. • The tank is full.
• The transmitter is configured with 

wrong probe type.
• Amplitude Threshold T1 is not correct.

• Check the product level.
• Check that correct probe type is 

configured.
• Check Amplitude Threshold T1.

Level accuracy seems off. • Configuration error. • Check the Reference Gauge Height 
parameter.

• Check status information and 
diagnostic information.

Integral display does not work. • Check the display configuration.
• Check loop power.
• Check Display connection.
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Errors Table 6-2 is a list of diagnostic messages that may be displayed on the 
Integral Display, on the 375 Field Communicator, in AMS Suite or by the 
Radar Configuration Tools (RCT) software. Errors normally result in Analog 
Output alarm.

Errors are indicated in RCT by the message “Transmitter malfunction”:

To see the error message do one of the following:
• Click the Read Gauge Status icon in the toolbar at the top of the 

RCT workspace.
• 1. Open the Advanced section in the RCT workspace Project Bar and 

click the Device Commands icon, 
or 
choose the Device Commands option from the View menu.
2. Open the folder named Diag and double-click the Read Gauge 
Status option.

Table 6-2.  Error messages.

TR
A

N
SM

IT
TE

R
M

AL
FU

N
C

TI
O

N

Error indication

Message Description Action
Invalid configuration.
LCD error code: CNFIG.

At least one configuration parameter 
is outside allowed range. 
NOTE: the default values are used 
until the problem is solved.

• Load default database and restart 
the transmitter.

• Contact Saab Rosemount service 
department if the problem persists.

RAM failure was detected 
during startup test.
LCD error code: 00001.

The transmitter performs an 
immediate reset.

Contact Rosemount service 
department.

FPROM failure was detected 
during startup test.

The transmitter performs an 
immediate reset.

Contact Rosemount service 
department.

Waveform acquisition failure.
LCD error code: 00006.

This error is probably caused by 
hardware failure.

Contact Rosemount service 
department.

EEPROM factory checksum.
LCD error code: 00007.

Checksum error in the factory 
configuration parameters. Can be 
caused by power failure during 
configuration or by hardware error. 
NOTE: the default values are used 
until the problem is solved.

Contact Rosemount service 
department.

EEprom user checksum error.
LCD error code: 00008.

Caused by error in the User 
Configuration parameters. Can be 
caused by power failure during 
configuration or by hardware error.
NOTE: the default values are used 
until the problem is solved

• Load default database and restart 
the transmitter.

• Contact Saab Rosemount service 
department if the problem persists.

Software error.
LCD error code: 00010.

 Contact Rosemount service 
department.

Probe failure.
LCD error code: 00013.

Probe is not detected. Check that the probe is correctly 
mounted (see “Changing the Probe” 
on page 6-20).
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Warnings Table 6-3 is a list of diagnostic messages that may be displayed on the 
Integral Display, on the Model 375 Field Communicator or by the Radar 
Configuration Tools (RCT) software. Warnings are less serious than errors 
and in most cases do not result in Analog Output alarms.

Warnings are indicated by a message at the bottom of the RCT workspace. To 
see the warning message do one of the following:

• Click the Read Gauge Status icon in the toolbar at the top of the 
RCT workspace.

• 1. Open the Advanced section in the RCT workspace Project Bar and 
click the Device Commands icon, 
or
choose the Device Commands option from the View menu.
2. Open the folder named Diag and double-click the Read Gauge 
Status option.

Table 6-3.  Warning messages.

Message Description Action
Reference pulse not 
found.

Possible cause:
• Reference pulse immersed in 

high dielectric liquid.
• Wrong threshold level T1.
• Hardware error.

• View the waveform plot and check 
amplitude threshold T1.

• Check that the tank is not overfull.

No level pulse is 
found.

Possible cause:
• Wrong threshold level T2.
• Liquid level in Dead Zone or 

below probe end.
• View the waveform plot and 

check amplitude threshold T2.
Interface pulse not 
found.

Possible cause:
• Wrong threshold level T3.
• Interface level too close to the 

upper product level.
• No level pulse detected.

• View the waveform plot and 
check amplitude threshold T3.

Internal temperature 
out of range.

-40 ºC<Internal Temperature<85 ºC. Contact Rosemount service 
department.

Volume computation 
warning. 

• Volume configuration error.
• Strapping table error.

• Check that correct tank type is 
selected for volume configuration.

• Check that tank dimensions for 
volume are correct.

• If strapping table is used, check the 
level vs. volume points.

Immersed probe. • Wrong threshold level T4.
• Reference pulse immersed in 

liquid.

• View the waveform plot and check 
amplitude threshold T4.
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Appendix A Reference Data
Specifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page A-1
Dimensional drawings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . page A-7
Ordering Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page A-12
Spare Parts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page A-18

SPECIFICATIONS

General
Product Rosemount Series 3300 Guided Wave Radar Level and Interface Transmitter; 

Model 3301 for Level (Interface available for fully immersed probe).
Model 3302 for Level and Interface.

Measurement principle Time Domain Reflectometry (TDR).
Reference Conditions Twin Lead probe, 77 °F (25 °C) water
Microwave Output Power Nominal 50 μW, Max. 2 mW.
CE-mark Complies with applicable directives (R&TTE, EMC, ATEX)
Start-up time < 10 s

Display / Configuration
Integral Display The integral display toggles between the following variables: level, distance, volume, 

internal temperature, interface distance, interface level, peak amplitudes, interface 
thickness, percent of range, analog current output.
Note! The Display can not be used for configuration purposes.

Output Units For Level, Interface and Distance: ft, inch, m, cm or mm.
For Volume: ft3, inch3, US gals, Imp gals, barrels, yd3, m3 or liters.

Output Variables Model 3301: Level, Distance (to product surface) and Volume. With fully immersed 
probe: Interface Level and Interface Distance.
Model 3302: Level, Distance (to product surface), Volume, Interface Level, Interface 
Distance and Upper Product Thickness.

HART® device for remote configuration Rosemount hand-held communicator Model 375.
PC for remote configuration Radar Configuration Tools software package. Rosemount AMS software.
Damping 0-60 s (10 s, default value)

Electric
Power supply Loop-powered (2-wire), 11 - 42 VDC (11 -30 VDC in IS applications,

16-42 VDC in Explosion-proof/Flame-proof applications).
Output Analog 4 - 20 mA, HART.
Signal on alarm Standard: Low=3.75 mA. High=21.75 mA.

Namur NE 43: Low=3.60 mA. High=22.50 mA.
Saturation levels Standard: Low=3.9 mA. High=20.8 mA.

Namur NE 43: Low=3.8 mA. High=20.5 mA.
IS parameters Ui = 30 V,li= 130 mA, Pi = 1 W, Li=0, Ci=0.
Cable entry ½ - 14 NPT for cable glands or conduit entries. Optional: M20 x 1.5 conduit/cable 

adapter or PG 13.5 conduit/cable adapter.
Output Cabling Twisted shielded pairs, 18-12 AWG.
www.rosemount.com
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Mechanical
Probes Coaxial: 1.3 ft (0.4 m) to 19.7 ft (6 m).

Rigid Twin Lead: 1.3 ft (0.4 m) to 9.8 ft (3 m).
Flexible Twin Lead: 3.3 ft (1 m) to 77.1 ft (23.5 m).
Rigid Single Lead: 1.3 ft (0.4 m) to 9.8 ft (3 m).
Flexible Single Lead: 3.3 ft (1 m) to 77.1 ft (23.5 m).
For further information see “Probe Selection Guide” on page 2-6.

Tensile strength Flexible Single Lead probe: 2698 lb (12 kN).
Flexible Twin Lead probe: 2023 lb (9 kN).

Collapse load Flexible Single Lead probe: 3597 lb (16 kN).
Sideway capacity Coaxial probe: 73.7 ft lbf, 3.7 lb at 19.7 ft (100 Nm, 1.67 kg at 6 m).

Rigid Twin Lead: 2.2 ft lbf, 0.22 lb at 9.8 ft (3 Nm, 0.1 kg at 3 m).
Rigid Single Lead: 4.4 ft lbf, 0.44 lb at 9.8 ft (6 Nm, 0.2 kg at 3 m).

Material exposed to tank atmosphere • 316/316L SST (EN 1.4404), PTFE, PFA(1) and O-ring materials (model code 1)
• Hastelloy® C276 (UNS N10276), PTFE, PFA(1) and O-ring materials (model code 2)
• Monel® 400 (UNS N04400), Teflon (PTFE, PFA) and O-ring materials (model code 3)
• PTFE(2) (model code 7)
• PTFE(2), 316L SST (EN 1.4404) and O-ring materials (model code 8)
• 316L SST (EN 1.4404), Ceramics (Al2O3), Graphite, (HTHP probe, model code H)
• 316L SST (EN 1.4404), Ceramics (Al2O3), Graphite, PFA (HP probe, model code P)
(See “Ordering Information” on page A-12).

Dimensions See “Dimensional drawings” on page A-7.
Probe angle 0 to 90 degrees from vertical axis.
Housing / Enclosure Polyurethane-covered Aluminium.
Flanges, Threads See “Ordering Information” on page A-12.
Height above flange See “Dimensional drawings” on page A-7.

Environment
Ambient temperature -40 °F to +185 °F ( -40 °C to +85 °C), depends on approval (see App. B). 

For the LCD display the temperature range is -4 °F to +185 °F (-20 °C to +85 °C).
See temperature diagrams on page A-6.

Storage temperature -40 °F to + 176 °F ( -40 °C to +80 °C).
Process temperature(3) Standard: -40 °F to +302 °F ( -40 °C to +150 °C).

HTHP: -76 °F to +752 °F ( -60 °C to +400 °C).
HP: -76 °F to +392 °F ( -60 °C to +200 °C).
See temperature and pressure diagrams on page A-4.

Process pressure(3) Standard(4): Full vacuum to 580 psig ( -1 to 40 Bar). 
HTHP: Full vacuum to 5000 psig (-1 to 345 Bar).
HP: Full vacuum to 5000 psig (-1 to 345 Bar).
See temperature and pressure diagrams on page A-4.

Humidity 0 - 100 % relative humidity
Ingress protection NEMA 4X, IP 66.
Telecommunication (FCC and R&TTE) FCC part 15 (1998) subpart B and R&TTE (EU directive 97/23/EC). Considered to be 

an unintentional radiator under the Part 15 rules.
Factory sealed Yes.
Vibration resistance  IEC 721-3-4 Class 4M4.
Electromagnetic compatibility Emission and Immunity: meets EN 61326-1 (1997) and amendment A1, class A 

equipment intended for use in industrial locations if installed in metallic vessels or 
still-pipes.
When rigid/flexible single and twin lead probes are installed in non-metallic or open 
vessels, influence of strong electromagnetic fields might affect measurements.

Built-in Lightning Protection Meets EN 61000-4-4 Severity Level 4 and EN 61000-4-5 Severity Level 4.
Pressure Equipment Directive (PED) Complies with 97/23/EC article 3.3.
Ordinary Location FM 3810, Compliance.
Boiler Approval CSA B51-97 Compliance.
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Measuring Performance 
Reference accuracy ± 0.2 inch (5 mm) for probes ≤ 16.4 ft (5 m).

± 0.1% of measured distance for probes >16.4 ft (5 m).
Repeatability ± 0.04 inch (1 mm).
Ambient Temperature Effect Less than 0.01 % of measured distance per °C.
Update interval 1 per second
Measuring range 16 inch (0.4 m) to 77 ft (23.5 m).

(1) PFA is a fluoropolymer with properties similar to PTFE.
(2) 1 mm PTFE cover.
(3) Final rating may be lower depending on flange and O-ring selection.
(4) For PTFE Covered Probe and Flange (model code 7) max pressure is 232 psig (16 Bar).
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Process Temperature 
and Pressure Rating

The tank connection consists of tank seal and a flange (EN, ANSI, Fisher or 
Masoneilan) or NPT or BSP/G threads (1 or 1.5 in. depending on probe type, 
see ”Ordering Information”.). 

Flange dimensions follows standard ANSI B 16.5 and EN 1092-1 type 05 
(DIN 2527 type B) blind flanges if the transmitter is ordered with a flange.

The tables below show temperature and pressure ratings for the following 
tank connection types:

• Standard (Std)
• High Temperature and High Pressure (HTHP)
• High Pressure (HP)

NOTE!
Final rating may be lower depending on flange and o-ring selection.

Figure A-1. Process 
temperature and pressure 
diagram for standard tank 
connections.

Figure A-2. Process 
temperature and pressure 
diagram for HTHP tank 
connection.

Figure A-3. Process 
temperature and pressure 
diagram for HP tank connection.
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The HP and HTHP versions have a ceramic tank seal, and graphite gaskets - 
no O-rings are used. 

The difference between the HP and HTHP versions is spacer material; PFA 
for HP, and ceramics for HTHP. Ceramic spacers allow for usage in 
applications with higher temperature.

The following table gives the temperature ranges for tank seal with different 
O-ring material (applicable for the Standard Tank Connection):

Table A-1.  Temperature range 
for different tank seal material.

Flange connection rating

Flange strength calculations are made with the following conditions:

Calculations show that the following rating applies:

ANSI

According to ANSI B16.5 Table 2-2.3.

Standard: max. 302 °F/580 psig (150 °C/40 Bar).

HP/HTHP: Class 2500.

EN

According to EN 1092-1 Table 18, material group 13E0.

Standard: maximum 302 °F/580 psig (150 °C/40 Bar).

HP/HTHP: PN 320.

Tank Seal with different 
O-ring material

Min. Temperature 
°F (°C) in air

Max. Temperature 
°F (°C) in air

Viton 5 (-15) 302 (150)
Ethylene Propylene (EPDM) -40 (-40) 266 (130)
Kalrez 6375 14 (-10) 302 (150)
Buna-N -31 (-35) 230 (110)

Bolting material Gasket Flange material Hub material

Standard/HTHP HP/HTHP

ANSI Stainless steel SA193 
B8M C1.2

Soft (1a) with min. 
thickness 1.6 mm.

Spiral wound gasket with 
nonmetallic filler (1b)

Stainless steel A182 
Gr. F316L and 
EN 10222-5-1.4404.

Stainless steel A479M 
316L or 
EN 10272-1.4404.EN EN 1515-1/-2 group 

13E0, A4-70.
Soft (EN 1514-1) with 
min. thickness 1.6 mm.

Spiral wound gasket with 
nonmetallic filler 
(EN 1514-2)
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Ambient Temperature When the Rosemount 3300 is installed in high temperature applications, it is 
important that the maximum ambient temperature is considered. Tank 
insulation should not exceed 4 inches (10 cm). 

The diagram below shows the maximum ambient temperature vs. process 
temperature: 

Figure A-4. Maximum ambient 
temperature vs. process 
temperature.

NOTE!
Maximum ambient temperature also depends on hazardous locations 
certfications.
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DIMENSIONAL 
DRAWINGS

Figure A-5. Rigid Twin Lead 

Dimensions are in inches (millimeter).
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½ - 14 NPT
Optional 
adapters:
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1.8 (45)1.1 (27)
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(3 m)

Flange
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Figure A-6. Flexible Twin Lead

Dimensions are in inches (millimeter).
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Ø 0.16 (4)

Ø 0.16 (4)
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s50
1.1 (27)

FL
E

X-
TW

IN
-L

E
A

D
-F

LA
N

G
E

_C
A

.E
PS

4.3 (110)

 6.8 (173)

3.5 (90)

1.4 (35)

4.1 (104)

4.5 (113)

Ø 0.16 (4)
Ø 0.16 (4)

9.6 (244)

L ≤ 77 feet 
(23.5 m)

Flange
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Figure A-7. Coaxial

Dimensions are in inches (millimeter).
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The Hastelloy® and 
Monel® probes are 
designed with a 
protective plate.
See also Section 3: 
Mechanical 
Installation.

For stainless steel,
the probe is welded 
to the flange.

15 (381)

HTHP/HP version
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Figure A-8. Flexible Single Lead

Dimensions are in inches (millimeter).
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a protective plate.
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covered probe
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Figure A-9. Rigid Single Lead

Dimensions are in inches (millimeter).

4.1 (104)

Ø 0.32 (8)
Ø 0.47 (12) for the 
PTFE covered probe
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For stainless steel,
the probe is welded 
to the flange.

Flange

The PTFE, Hastelloy® 
and Monel® probes 
are designed with a 
protective plate.
See also Section 3: 
Mechanical 
Installation.

15 (381)

Ø 0.32 (8)
Ø 0.47 (12) for the 
PTFE covered probe

HTHP/HP version
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ORDERING INFORMATION
Model Code 3301, Level in Liquids  

Model Product Description

3301 Guided Wave Radar Level Transmitter (interface available for fully immersed probe)

Code Signal Output

H 4-20 mA with HART® communication

Code Housing Material

A Polyurethane-covered Aluminum

Code Conduit / Cable Threads

1 ½  - 14 NPT
2 M20 x 1.5 adapter
3 PG 13.5 adapter

Code Operating Temperature and Pressure

S - 15 psig (-1bar) to 580 psig (40 bar) @ 302 °F (150 °C) (1)

H High Temp / High Pressure(2): 2940 psi @ 750 °F and 5000 psi @ 100 °F (203 bar @ 400 °C and 345 bar @ 38 °C) according 
to ANSI Class 2500 (Probe Type 3A, 3B and 4A)

P High Pressure(2). Max 500 °F (200 °C): 3500 psi @ 500 °F and 5000 psi @ 100 °F (243 bar @ 200 °C and 345 bar @ 38 °C) 
according to ANSI Class 2500 (Probe Type 3A, 3B and 4A)

Code Material of Construction(3): Process Connection / Probe

1 316 / 316 L SST (EN 1.4404)
2 Hastelloy® C-276 (UNS N10276). Available for probe type 3A, 3B and 4A.
3 Monel® 400 (UNS N04400). Available for probe type 3A, 3B and 4A
7 PTFE covered probe and flange. Available for probe type 4A and 5A, Flanged versions 
8 PTFE covered probe. Available for probe type 4A and 5A

Code Sealing, O-ring Material (Consult factory  for other o-ring materials)

N None(4)

V Viton® fluoroelastomer
E Ethylene Propylene
K Kalrez® 6375 perfluoroelastomer
B Buna-N

Code Probe Type Process Connection Probe Lengths

1A Rigid Twin Lead Flange or 1.5 inch Thread Min: 1 ft 4 in. (0.4 m). Max: 9 ft 10 in. (3 m)
2A Flexible Twin Lead with weight Flange or 1.5 inch Thread Min: 3 ft 4 in. (1 m). Max: 77 ft 1 in. (23.5 m)
3A Coaxial Flange, 1 or 1.5 inch Thread Min: 1 ft 4 in. (0.4 m). Max: 19 ft 8 in. (6 m)
3B Coaxial, perforated for easier cleaning Flange, 1 or 1.5 inch Thread Min: 1 ft 4 in. (0.4 m). Max: 19 ft 8 in. (6 m)
4A Rigid Single Lead Flange, 1 or 1.5 inch Thread Min: 1 ft 4 in. (0.4 m). Max: 9 ft 10 in. (3 m)
5A Flexible Single Lead with weight Flange, 1 or 1.5 inch Thread Min: 3 ft 4 in. (1 m). Max: 77 ft 1 in. (23.5 m)
5B Flexible Single Lead with chuck (5) Flange, 1 or 1.5 inch Thread Min: 3 ft 4 in. (1 m). Max: 77 ft 1 in. (23.5 m)

Code Probe Length Units

E English (feet, inch)
M Metric (meters, centimeters)

Code Total Probe Length (6) (feet/m)

xx 0 - 77 ft or 0-23 m

Code Total Probe Length (6) (inch/cm)

xx 0 - 11 inch or 0-99 cm
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Code Process Connection - Size / Type (consult factory for other process connections)

ANSI Flanges in 316L SST (ASME A182)
AA 2 inch ANSI, 150 lb
AB 2 inch ANSI, 300 lb
AC 2 inch ANSI, 600 lb (HTHP / HP units)
AD 2 inch ANSI, 900 lb (HTHP / HP units)
AE 2 inch ANSI, 1500 lb (HTHP / HP units)
BA 3 inch ANSI, 150 lb
BB 3 inch ANSI, 300 lb
BC 3 inch ANSI, 600 lb (HTHP / HP units)
BD 3 inch ANSI, 900 lb (HTHP / HP units)
BE 3 inch ANSI, 1500 lb (HTHP / HP units)
CA 4 inch ANSI, 150 lb
CB 4 inch ANSI, 300 lb
CC 4 inch ANSI, 600 lb (HTHP / HP units)
CD 4 inch ANSI, 900 lb (HTHP / HP units)
CE 4 inch ANSI, 1500 lb (HTHP / HP units)
DA 6 inch ANSI, 150 lb
EN (DIN) Flanges in 316L SST (EN 1.4404)
HB DN50, PN40
HC DN50, PN64 (HTHP / HP units)
HD DN50, PN100 (HTHP / HP units)
IA DN80, PN16
IB DN80, PN40
IC DN80, PN64 (HTHP / HP units)
ID DN80, PN100 (HTHP / HP units)
JA DN100, PN16
JB DN100, PN40
JC DN100, PN64 (HTHP / HP units)
JD DN100, PN100 (HTHP / HP units)
KA DN150, PN16
Threaded Connections
RA 1 ½ inch NPT thread
RB 1 inch NPT thread (only available for probe type 3A, 3B, 4A, 5A, 5B)
SA 1 ½ inch BSP (G 1 ½ inch) thread
SB 1 inch BSP (G 1 inch) thread (only available for probe type 3A, 3B, 4A, 5A, 5B)
Proprietary Flanges
TF Fisher - proprietary 316 Stainless Steel (for 249B cages) Torque Tube Flange
TT Fisher - proprietary 316 Stainless Steel (for 249C cages) Torque Tube Flange
TM Masoneilan - proprietary 316 Stainless Steel Torque Tube Flange

(1) Process seal rating. Final rating depends on flange and O-ring selection. See “Process Temperature and Pressure Rating” on page A-4.
(2) Requires option None for sealing (no O-ring). Only for SST (Material of Construction model code 1).
(3) For other materials, consult factory.
(4) Requires High Temperature High Pressure (code H) or High Pressure (code P) probe.
(5) Extra length for fastening is added in factory.
(6) Probe weight included if applicable. Give the total probe length in feet and inches or meters and centimeters, depending on selected probe length unit. 

If tank height is unknown, please round up to an even length when ordering. Probes can be cut to exact length in field. Maximum allowable length is 
determined by process conditions.
A-13



Reference Manual
00809-0100-4811, Rev CA

February 2006Rosemount 3300 Series
Code Hazardous Locations Certifications
NA No Hazardous Locations Certifications
E1 ATEX Flameproof
E5 FM Explosion Proof
E6 CSA Explosion Proof
E7 IECEx Flameproof
I1 ATEX Intrinsic Safety
I5 FM Intrinsic Safety and Non-Incendive
I6 CSA Intrinsic Safety and Non-Incendive
I7 IECEx Intrinsic Safety
KA ATEX and CSA Flameproof/Explosionproof
KB FM and CSA Explosionproof
KC ATEX and FM Flameproof/Explosionproof
KD ATEX and CSA Intrinsic Safety
KE FM and CSA Intrinsic Safety
KF ATEX and FM Intrinsic Safety
Code Options
M1 Integral digital display
BT Bar Code Tag with tag number and purchase order number
P1 Hydrostatic testing
N2 NACE material recommendation per MR 01-75 (1)

LS Long stud 9.8 in (250 mm) for flex. single lead probe to prevent contact with wall/nozzle.Standard height is 3.9 in (100 mm)
CP Centering disc PTFE(2)(3)

CS Centering disc SST(2)(3)

T0 Terminal block without transient protection
Cx - Special Configuration (Software)
C1 Factory configuration (CDS required with order)
C4 Namur alarm and saturation levels, high alarm
C5 Namur alarm and saturation levels, low alarm
C8 Low alarm (4) (standard Rosemount alarm and saturation levels)
Qx - Special Certs
Q4 Calibration Data Certification
Q8 Material Traceability Certification per EN 10204 3.1B(5)

(1) Valid for probe type 3A, 3B and 4A.
(2) Not available with PTFE covered probes.
(3) Valid for probe type 2A, 4A and 5A. Flanged connections only.
(4) The standard alarm setting is high.
(5) Option available for pressure retaining wetted parts.

Example Model String: 3301-H-A-1-S-1-V-1A-M-02-05-AA-I1-M1C1. E-02-05, means 2 ft and 5 inch probe length. M-02-05, means 2.05 m.
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Model Code 3302, Level and Interface in Liquids  

Model Product Description

3302 Guided Wave Radar Level and Interface Transmitter

Code Signal Output

H 4-20 mA with HART® communication

Code Housing Material

A Polyurethane-covered Aluminum

Code Conduit / Cable Threads

1 ½  - 14 NPT
2 M20 x 1.5 adapter
3 PG 13.5 adapter

Code Operating Temperature and Pressure

S - 15 psig (-1bar) to 580 psig (40 bar) @ 302 °F (150 °C) (1)

(1) Process seal rating. Final rating depends on flange and O-ring selection. See “Process Temperature and Pressure Rating” on page A-4.

H High Temp / High Pressure(2): 2940 psi @ 750 °F and 5000 psi @ 100 °F (203 bar @ 400 °C and 345 bar @ 38 °C) according 
to ANSI Class 2500 (Probe Type 3A, 3B and 4A)

(2) Requires option None for sealing (no O-ring). Only for SST (Material of Construction model code 1).

P High Pressure(2). Max 500 °F (200 °C): 3500 psi @ 500 °F and 5000 psi @ 100 °F (243 bar @ 200 °C and 345 bar @ 38 °C) 
according to ANSI Class 2500 (Probe Type 3A, 3B and 4A)

Code Material of Construction(3): Process Connection / Probe

(3) For other materials, consult factory.

1 316 / 316 L SST (EN 1.4404)
2 Hastelloy® C-276 (UNS N10276). Available for probe type 3B and 4A.
3 Monel® 400 (UNS N04400). Available for probe type 3B and 4A
7 PTFE covered probe and flange. Available for probe type 4A, Flanged version 
8 PTFE covered probe. Available for probe type 4A

Code Sealing, O-ring Material (Consult factory  for other o-ring materials)

N None(4)

(4) Requires High Temperature High Pressure (code H) or High Pressure (code P) probe. 

V Viton® fluoroelastomer
E Ethylene Propylene
K Kalrez® 6375 perfluoroelastomer
B Buna-N

Code Probe Type Process Connection Probe Lengths

1A Rigid Twin Lead Flange or 1.5 in. Thread Min: 1 ft 4 in. (0.4 m). Max: 9 ft 10 in. (3 m)
2A Flexible Twin Lead with weight Flange or 1.5 in. Thread Min: 3 ft 4 in. (1 m). Max: 77 ft 1 in. (23.5 m)
3B Coaxial for interface measurements Flange, 1 or 1.5 in. Thread Min: 1 ft 4 in. (0.4 m). Max: 19 ft 8 in. (6 m)
4A Rigid Single Lead Flange, 1 or 1.5 in. Thread Min: 1 ft 4 in. (0.4 m). Max: 9 ft 10 in. (3 m)

Code Probe Length Units

E English (feet, inch)
M Metric (meters, centimeters)

Code Total Probe Length (5) (feet/m)

(5) Probe weight included if applicable. Give the total probe length in feet and inches or meters and centimeters, depending on selected probe length unit. If 
tank height is unknown, please round up to an even length when ordering. Probes can be cut to exact length in field. Maximum allowable length is 
determined by process conditions.

xx 0 - 77 ft or 0-23 m

Code Total Probe Length (5) (inch/cm)

xx 0 - 11 inch or 0-99 cm
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Code Process Connection - Size / Type (consult factory for other process connections)
ANSI Flanges in 316L SST (ASME A182)
AA 2 inch ANSI, 150 lb
AB 2 inch ANSI, 300 lb
AC 2 inch ANSI, 600 lb (HTHP / HP units)
AD 2 inch ANSI, 900 lb (HTHP / HP units)
AE 2 inch ANSI, 1500 lb (HTHP / HP units)
BA 3 inch ANSI, 150 lb
BB 3 inch ANSI, 300 lb
BC 3 inch ANSI, 600 lb (HTHP / HP units)
BD 3 inch ANSI, 900 lb (HTHP / HP units)
BE 3 inch ANSI, 1500 lb (HTHP / HP units)
CA 4 inch ANSI, 150 lb
CB 4 inch ANSI, 300 lb
CC 4 inch ANSI, 600 lb (HTHP / HP units)
CD 4 inch ANSI, 900 lb (HTHP / HP units)
CE 4 inch ANSI, 1500 lb (HTHP / HP units)
DA 6 inch ANSI, 150 lb
EN (DIN) Flanges in 316L SST (EN 1.4404)
HB DN50, PN40
HC DN50, PN64 (HTHP / HP units)
HD DN50, PN100 (HTHP / HP units)
IA DN80, PN16
IB DN80, PN40
IC DN80, PN64 (HTHP / HP units)
ID DN80, PN100 (HTHP / HP units)
JA DN100, PN16
JB DN100, PN40
JC DN100, PN64 (HTHP / HP units)
JD DN100, PN100 (HTHP / HP units)
KA DN150, PN16
Threaded Connections
RA 1 ½ inch NPT thread
RB 1 inch NPT thread (only available for probe type 3B and 4A)
SA 1 ½ inch BSP (G 1 ½ inch) thread
SB 1 inch BSP (G 1 inch) thread (only available for probe type 3B and 4A)
Proprietary Flanges.
TF Fisher - proprietary 316 Stainless Steel (for cage 249B) Torque Tube Flange
TT Fisher - proprietary 316 Stainless Steel (for cage 249C) Torque Tube Flange
TM Masoneilan - proprietary 316 Stainless Steel Torque Tube Flange
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Code Hazardous Locations Certifications
NA No Hazardous Locations Certifications
E1 ATEX Flameproof
E5 FM Explosion Proof
E6 CSA Explosion Proof
E7 IECEx Flameproof
I1 ATEX Intrinsic Safety
I5 FM Intrinsic Safety and Non-Incendive
I6 CSA Intrinsic Safety and Non-Incendive
I7 IECEx Intrinsic Safety
KA ATEX and CSA Flameproof/Explosionproof
KB FM and CSA Explosionproof
KC ATEX and FM Flameproof/Explosionproof
KD ATEX and CSA Intrinsic Safety
KE FM and CSA Intrinsic Safety
KF ATEX and FM Intrinsic Safety
Code Options
M1 Integral digital display
BT Bar Code Tag with tag number and purchase order number
P1 Hydrostatic testing
N2 NACE material recommendation per MR 01-75 (1)

CP Centering disc PTFE(2)

CS Centering disc SST(2)

T0 Terminal block without transient protection
Cx - Special Configuration (Software)
C1 Factory configuration (CDS required with order)
C4 Namur alarm and saturation levels, high alarm
C5 Namur alarm and saturation levels, low alarm
C8 Low alarm (3) (standard Rosemount alarm and saturation levels)
Qx - Special Certs
Q4 Calibration Data Certification
Q8 Material Traceability Certification per EN 10204 3.1B(4)

(1) Valid for probe type 3B and 4A.
(2) Valid for probe type 2A, 4A and 5A. Flanged connections only.
(3) The standard alarm setting is high.
(4) Option available for pressure retaining wetted parts.

Example Model String: 3302-H-A-1-S-1-V-1A-M-02-05-AA-I1-M1C1. E-02-05 means 2 ft and 5 inch probe length. M-02-05 means 2.05 m. 
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SPARE PARTS
Spare parts list Transmitter head Model 3301/3302

Model Product Description
3301 Transmitter head Model 3301
3302 Transmitter head Model 3302

Code Signal Output
H 4-20 mA with HART communication

Code Housing Material
A Polyurethane-covered Aluminum

Code Conduit Threads/Cable Threads
1 ½ - 14 NPT
2 M20x1.5 adapter
3 PG 13.5 adapter

Code Operating Temperature and Pressure
N Not applicable

Code Material of Construction: Process Connection/Probe
0 Not applicable

Code Sealing, O-ring Material (Consult factory for other o-ring materials)
N Not applicable

Code Probe Type Applicable for Model Allowable Process Connection
9R For rigid probes 3301 & 3302 Flange or 1.5 “ Thread
9F For flexible probes 3301 & 3302 Flange or 1.5 “ Thread

Code Probe Length Unit
N Not applicable

Code Total Probe Length (feet/m)
00 Not applicable

Code Total Probe Length (inch/cm)
00 Not applicable

Code Hazardous Locations Certifications
NA No hazardous Locations Certifications
E1 ATEX Flame-proof
E5 FM Explosion-proof
E6 CSA Explosion-proof
E7 IECEx Flame-proof
I1 ATEX Intrinsic Safety
I5 FM Intrinsic Safety and Non-Incendive
I6 CSA Intrinsic Safety and Non-Incendive
I7 IECEx Intrinsic Safety
KA ATEX and CSA Flame-proof/Explosion-proof
KB FM and CSA Explosion-proof
KC ATEX and FM Flame-proof/Explosion-proof
KD ATEX and CSA Intrinsic Safety
KE FM and CSA Intrinsic Safety
KF ATEX and FM Intrinsic Safety
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Code Options
M1 Integral Digital Display
BT Bar Code Tag
T0 Terminal block without transient protection

Cx - Special Configuration (Software)
C1 Factory configuration (CDS required with order)
C4 Namur alarm and saturation levels, high alarm
C5 Namur alarm and saturation levels, low alarm
C8 Low alarm(1) (standard Rosemount alarm and saturation levels)

(1) The standard alarm setting is high.

Cx - Special Certs
Q4 Calibration Data Certification
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Spare parts list Probe Model 3301/3302

Model Product Description
3309 Spare probe

Code Signal Output
N Not applicable

Code Housing Material
N Not applicable

Code Conduit Threads/Cable Threads
0 Not applicable

Code Operating Temperature and Pressure
S Standard: -15 psig (-1 Bar) to 580 psig (40 Bar) @ 302 °F (150 °C) (1)

(1) Process seal rating. Final rating depends on flange and O-ring selection, see “Process Temperature and Pressure Rating” on page A-4.

H High Temp / High Pressure
P High Pressure

Code Material of Construction: Process Connection/Probe
1 316 / 316L SST (EN 1.4404), Teflon (PTFE, PFA)
2 Hastelloy C276, Teflon (PTFE, PFA). Available for probe type 3A, 3B and 4A (with plate design if not threaded)
3 Monel 400, Teflon (PTFE, PFA). Available for probe types 3A, 3B and 4A (with plate design if not threaded)
7 PTFE Covered Probe and Flange valid for probe 4A, 5A flanged version only (with plate design)
8 PTFE Covered Probe and Flange valid for probe 4A, 5A

Code Sealing, O-ring Material (Consult factory for other 
o-ring materials)

V Viton
E Ethylene Propylene
K Kalrez 6375
B Buna-N
N None (HP/HTHP)

Code Probe Type Applicable 
for Model

Allowable Process 
Connection

Probe Length

1A Rigid Twin Lead. 3301 & 3302 Flange or 1.5 “ Thread Min: 1 ft 11 inch (0.6 m)
Max: 9 ft 10 inch (3 m)

2A Flexible Twin Lead with weight 3301 & 3302 Flange or 1.5 “ Thread Min: 3 ft 3 inch (1 m)
Max: 65 ft 7 inch (20 m)

3A Coaxial 3301 Flange or 1”, 1.5 “ Thread Min: 1 ft 3 inch (0.4 m)
Max: 19 ft 8 inch (6 m)

3B Coaxial perforated, for interface or easier 
cleaning

3301 & 3302 Flange or 1”, 1.5 “ Thread Min: 1ft 3 inch (0.4 m)
Max: 19 ft 8 inch (6 m)

4A Rigid Single Lead 3301 Flange or 1”, 1.5 “ Thread Min: 1 ft 11 inch (0.6 m)
Max: 9 ft 10 inch (3 m)

5A Flexible Single Lead with weight d=4 mm 3301 Flange or 1”, 1.5 “ Thread Min: 3 ft 3 inch (1 m)
Max: 65 ft 7 inch (20 m)

5B Flexible Single Lead with chuck d=4 mm(2)

(2) Extra length for fastening is added in factory.

3301 Flange or 1”, 1.5 “ Thread Min: 3 ft 3 inch (1 m)
Max: 65 ft 7 inch (20 m)

Code Probe Length Unit
E English (feet, inch)
M Metric (meters, centimeters)

Code Total Probe Length(3) (feet/m)

(3) Probe weight included if applicable. Give the total probe length in feet and inches or meters and centimeters, depending on selected probe length unit 
(see Model String Example). If tank height is unknown, please round up to an even length when ordering - probes can be cut to exact length in field. 
Maximum allowable length is determined by process conditions.

xx 0-65 feet or 0-20 m
Code Total Probe Length(3) (inch/cm)

xx 0-11 inches or 0-99 centimeters
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Code Process Connection - Size/Type (consult factory for other process connections)
ANSI Flanges in ASME A182 Gr. F316L SST
AA 2 inch ANSI, 150 lb
AB 2 inch ANSI, 300 lb
AC 2 inch ANSI, 600 lb (HTHP / HP)
AD 2 inch ANSI, 900 lb (HTHP / HP)
AE 2 inch ANSI, 1500 lb (HTHP / HP)
BA 3 inch ANSI, 150 lb
BB 3 inch ANSI, 300 lb
BC 3 inch ANSI, 600 lb (HTHP / HP)
BD 3 inch ANSI, 900 lb (HTHP / HP)
BE 3 inch ANSI, 1500 lb (HTHP / HP)
CA 4 inch ANSI, 150 lb
CB 4 inch ANSI, 300 lb
CC 4 inch ANSI, 600 lb (HTHP / HP)
CD 4 inch ANSI, 900 lb (HTHP / HP)
CE 4 inch ANSI, 1500 lb (HTHP / HP)
DA 6 inch ANSI, 150 lb
EN (DIN) Flanges in 10222-5-1.4404 SST
HB DN50, PN40
HC DN50, PN64 (HTHP / HP)
HD DN50, PN100 (HTHP / HP)
IA DN80, PN16
IB DN80, PN40
IC DN80, PN64
ID DN80, PN100
JA DN100, PN16
JB DN100, PN40
JC DN100, PN64 (HTHP / HP)
JD DN100, PN100 (HTHP / HP)
KA DN150, PN16
Proprietary Flanges
TF Fisher - Proprietary 316 Stainless Steel (for cage 249B) Torque Tube Flange. Outer diameter: 9.0 in. (228.6 mm).
TT Fisher - Proprietary 316 Stainless Steel (for cage 249C) Torque Tube Flange. Outer diameter: 5.7 in. (144.5 mm).
TM Masoneilan - Proprietary 316 Stainless Steel Torque Tube Flange. Outer diameter: 7.5 in. (191 mm).
Threaded
RA 1.5 inch NPT thread
RB 1 inch NPT thread (only available for probe type 3A, 3B, 4A, 5A, 5B)
SA 1½ inch BSP (G 1½ inch) thread
SB 1 inch BSP (G 1 inch) thread (only available for probe type 3A, 3B, 4A, 5A, 5B)
Antenna with plate design for customer supplied flange
PA Antenna with 2 in. / DN50 plate
PB Antenna with 3 in. / DN80 plate
PC Antenna with 4 in. / DN100 plate
PD Antenna with 6 in. / DN150 plate
PE Antenna with 8 in. / DN200 plate
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Code Hazardous Locations Certifications
NA Not applicable
Code Options
P1 Hydrostatic testing
N2 NACE material recommendation per MR 01-75(1)

LS Long Stud 9.8 in. (250 mm) for Flexible Single Lead probe. Prevents the wire from contacting wall/nozzle. Standard height is 3.9 
in. (100 mm).

CP Centering disc PTFE(2)

CS Centering disc SST(2)

Qx - Special Certs
Q8 Material Traceability Certification per EN 10204 3.1B(3)

(1) Valid for probe type 3A, 3B and 4A.
(2) Valid for probe type 2A, 4A and 5A. Flanged connections only.
(3) Option available for pressure retaining wetted parts
A-22



Reference Manual 
00809-0100-4811, Rev CA
February 2006 Rosemount 3300 Series
Spare parts list Other Spares and Accessories Model 3301/3302

Code Process Connection - Size/Type (consult factory for other process connections)
Display kit and covers
03300-0670-0002 Integral Display Kit (including cover)
03300-0670-0001 Integral Display Kit (does not include cover)
03300-7002-0001 Integral Display Cover (long)
03300-7002-0002 Electronics cover
03300-7002-0003 O-ring for Electronics cover, Integral display cover (pkg of 12)
Other spares
03300-7003-0001 Transient Terminal block assembly
03300-7001-0001 End piece kit Rigid Twin lead
03300-7001-0002 Weight kit Flexible Twin lead
03300-7001-0003 Weight kit Flexible Single lead
Other accessories
03300-7004-0001 Viatec HART Modem and cables (RS 232 connection)
03300-7004-0002 Viatec HART Modem and cables (USB connection)
00822-0100-4747 Rosemount Radar Configuration Tool (RCT)
Cable glands
03300-7000-0001 Cable Gland 8-15mm, 1/2NPT Mo Brass Nickel Plated, KV1
03300-7000-0002 Cable Gland 4-8mm, 1/2NPT Brass, KVE7, EExd
03300-7000-0003 Cable Gland 8-11mm, 1/2NPT Brass, KVE8, EExd
03300-7000-0004 Cable Gland 6-12mm, 1/2 NPT Polyamide Grey
Centering discs(1)

(1) If a centering disc is required for a flanged probe the centering disc can be ordered with options CS or CP in the model code. If a centering disc is required 
for a threaded connection or as a spare part it should be ordered using the item numbers listed below.

03300-1655-0001 Kit, 2 Inch Centering Disk, SS, Rigid Single 
03300-1655-0002 Kit, 3 Inch Centering Disk, SS, Rigid Single 
03300-1655-0003 Kit, 4 Inch Centering Disk, SS, Rigid Single 
03300-1655-0004 Kit, 6 Inch Centering Disk, SS, Rigid Single 
03300-1655-0005 Kit, 8 Inch Centering Disk, SS, Rigid Single 
03300-1655-0006 Kit, 2 Inch Centering Disk, PTFE, Rigid Single 
03300-1655-0007 Kit, 3 Inch Centering Disk, PTFE, Rigid Single 
03300-1655-0008 Kit, 4 Inch Centering Disk, PTFE, Rigid Single 
03300-1655-0009 Kit, 6 Inch Centering Disk, PTFE, Rigid Single 
03300-1655-0010 Kit, 8 Inch Centering Disk, PTFE, Rigid Single 
03300-1655-1001 Kit, 2 Inch Centering Disk, SS, Single / Twin Flex Lead
03300-1655-1002 Kit, 3 Inch Centering Disk, SS, Single / Twin Flex Lead 
03300-1655-1003 Kit, 4 Inch Centering Disk, SS, Single / Twin Flex Lead 
03300-1655-1004 Kit, 6 Inch Centering Disk, SS, Single / Twin Flex Lead 
03300-1655-1005 Kit, 8 Inch Centering Disk, SS, Single / Twin Flex Lead 
03300-1655-1006 Kit, 2 Inch Centering Disk, PTFE, Single / Twin Flex Lead
03300-1655-1007 Kit, 3 Inch Centering Disk, PTFE, Single / Twin Flex Lead 
03300-1655-1008 Kit, 4 Inch Centering Disk, PTFE, Single / Twin Flex Lead 
03300-1655-1009 Kit, 6 Inch Centering Disk, PTFE, Single / Twin Flex Lead 
03300-1655-1010 Kit, 8 Inch Centering Disk, PTFE, Single / Twin Flex Lead 
A-23



Reference Manual
00809-0100-4811, Rev CA

February 2006Rosemount 3300 Series
A-24



Reference Manual 
00809-0100-4811, Rev CA
February 2006 Rosemount 3300 Series
Appendix B Product Certifications
Safety Messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page B-1
EU Conformity . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page B-2
European ATEX Directive Information  . . . . . . . . . . . . . . . page B-3
Hazardous Locations Certifications . . . . . . . . . . . . . . . . . page B-5
Combination of Approvals . . . . . . . . . . . . . . . . . . . . . . . . . page B-8
Approval Drawings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page B-11

SAFETY MESSAGES Procedures and instructions in this section may require special precautions to 
ensure the safety of the personnel performing the operations. Information that 
raises potential safety issues is indicated by a warning symbol ( ). Please 
refer to the following safety messages before performing an operation 
preceded by this symbol.

Explosions could result in death or serious injury:
Verify that the operating environment of the gauge is consistent with the appropriate 
hazardous locations certifications.

Before connecting a HART-based communicator in an explosive atmosphere, make 
sure the instruments in the loop are installed in accordance with intrinsically safe or 
non-incendive field wiring practices.

Do not remove the gauge cover in explosive atmospheres when the circuit is alive.

Failure to follow safe installation and servicing guidelines could result in death or 
serious injury:
Make sure the transmitter is installed by qualified personnel and in accordance with 
applicable code of practice.

Use the equipment only as specified in this manual. Failure to do so may impair the 
protection provided by the equipment.

Do not perform any service other than those contained in this manual unless you are 
qualified.

A safety isolator such as a zener barrier is always is always needed for intrinsic safety.
www.rosemount.com
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EU CONFORMITY The EC declaration of conformity for all applicable European directives for this 
product can be found on the Rosemount website at www.rosemount.com. A 
hard copy may be obtained by contacting our local sales representative.

High voltage that may be present on leads could cause electrical shock:
Avoid contact with leads and terminals. 

Make sure the main power to the Radar Transmitter is off and the lines to any other 
external power source are disconnected or not powered while wiring the transmitter.

Probes covered with plastic and/or with plastic discs may generate an ignition-capable 
level of electrostatic charge under certain extreme conditions. Therefore, when the 
probe is used in a potentially explosive atmosphere, appropriate measures must be 
taken to prevent electrostatic discharge.
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EUROPEAN ATEX 
DIRECTIVE 
INFORMATION

Intrinsic Safety The Rosemount 3300 Series Guided Wave Radar Level and Interface 
Transmitter that has the following label attached has been certified to comply 
with Directive 94/9/EC of the European Parliament and the Council as 
published in the Official Journal of the European Communities No. L 100/1 on 
19-April-1994.

Figure B-1. Approval Label 
ATEX (BASEEFA) and Name 
Plate

The following information is provided as part of the label of the transmitter:
• Name and address of the manufacturer (Rosemount).
• CE Conformity Marking

• Complete model number
• The serial number of the device
• Year of construction
• Marking for explosion protection:

• EEx ia IIC T4 (-50 °C ≤ Ta ≤ +70 °C)
Ui=30 V, Ii=130 mA, Pi=1 W, Ci=0, Li=0

• BASEEFA ATEX certificate number: BAS02ATEX1163X

Special Conditions for Safe Use (X):

The apparatus is not capable of withstanding the 500 V test as defined in 
clause 6.4.12 of EN 50020. This must be considered during installation.

When used in a potentially explosive atmosphere where the use of 
equipment-category 1 apparatus is required, appropriate measures must be 
taken to prevent electrostatic discharge.
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Flameproof The Rosemount 3300 Series Guided Wave Radar Level and Interface 
Transmitter that has the following label attached has been certified to comply 
with Directive 94/9/EC of the European Parliament and the Council as 
published in the Official Journal of the European Communities No. L 100/1 on 
19-April-1994.

Figure B-2. Approval Label 
ATEX (KEMA) and Name Plate

The following information is provided as part of the label of the transmitter:
• Name and address of the manufacturer (Rosemount).
• CE Conformity Marking

• Complete model number
• The serial number of the device
• Year of construction
• Marking for explosion protection:

• EEx d [ia] IIC T6 (-40 °C <Ta < +75 °C)
• KEMA ATEX certificate number: KEMA 01ATEX2220X
• Um=250 V.

Special Conditions for Safe Use (X):

When used in a potentially explosive atmosphere where the use of 
equipment-category 1 apparatus is required, appropriate measures must be 
taken to prevent electrostatic discharge.
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HAZARDOUS 
LOCATIONS 
CERTIFICATIONS

The Rosemount 3300 Series Guided Wave Radar Level and Interface 
Transmitters that have the following labels attached have been certified to 
comply with the requirements of the approval agencies noted.

Factory Mutual (FM) 
Approvals

Project ID: 3013394

Figure B-3. Approval Labels 
Factory Mutual (FM)

For connection in ambients above 70 °C, use wiring rated for 90 °C 
minimum.

E5 Explosion-Proof for Class I, Division 1, Groups B, C and D.
Dust-Ignition proof for Class II/III, Division 1, Groups E, F and G; with 
intrinsically safe connections to Class I, II, III, Div 1, Groups A, B, C, D, 
E, F AND G. 
Temperature class T5 @+85 °C.
Ambient temperature limits: -40°C to + 85°C
Factory Sealed.

I5 Intrinsically Safe for Class I, II, III, Division 1, Groups A, B, C, D, E, F 
and G. 
Intrinsically Safe for Class I, Zone 0, AEX ia IIC T4 Ta=70°C.
Temperature code T4 at 70°C max ambient.
Control Drawing: 9150077-944.
Non-incendive for Class I, Division 2, Groups A, B, C and D.
Suitable for Class II, III, Division 2, Groups F and G.
Non-incendive maximum operating parameters: 42 V, 25 mA.
Temperature code T4 at 70°C max ambient.
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Canadian Standards 
Association (CSA) 
Approval

Cert. no. 2002.1250250.

Figure B-4. Approval Label 
Canadian Standards Association 
(CSA)

E6 Explosion-Proof for Class I, Division 1, Groups C and D.
Dust-Ignition proof for Class II, Division 1 and 2, Groups G and Coal 
Dust.
Dust-Ignition proof for Class III, Division 1, Hazardous Locations 
[Ex ia IIC T6].
Ambient temperature limits: -40°C to + 85°C.
Factory Sealed.

I6 Intrinsically Safe: Ex ia IIC T4. 
Intrinsically Safe for Class I, Division 1, Groups A, B, C and D.
Temperature code T4.
Control Drawing: 9150077-945.
Non-incendive for Class III, Division 1, Hazardous Locations.
Non-incendive for Class I, Division 2, Groups A, B, C and D.
Ambient temperature limits: -40 °C to + 70 °C.
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IECEx Approval

Figure B-5. Approval Labels 
IECEx.

E7 Flameproof: 
Ex d [ia] IIC T6 (Tamb = +60 °C).
IECEx TSA 04.0013X.

Conditions of Certification

The apparatus metallic enclosure must be electrically bonded to earth. The 
conductor used for the connection shall be equivalent to a copper conductor 
of 4 mm2 minimum cross-sectional area.

Where it is required that an unused conduit entry is to be closed by means of 
the blanking plug, the plug supplied by the equipment manufacturer with this 
equipment is certified for this purpose under this certification.

Maximum voltage Um=250 V.

I7 Intrinsic Safety:
Ex ia IIC T4 (Tamb = +60 °C).
IECEx TSA 04.0006X.
Ui=30 V, Ii=130 mA, Pi=1 W, Ci=0 nF, Li=0 mH.

Conditions of Certification

The programming port must not be used in the hazardous area.

The apparatus metallic enclosure must be electrically bonded to earth. The 
conductor used for the connection shall be equivalent to a copper conductor 
of 4 mm2 minimum cross-sectional area.

The input parameters stated above must be taken into consideration during 
the installation of the apparatus.
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COMBINATION OF 
APPROVALS

Figure B-6. Approval Label 
ATEX Flame-Proof and 
Canadian Standards Association 
(CSA) Explosion-Proof.

Figure B-7. Approval Label 
CSA Explosion-Proof and 
FM Explosion-Proof.
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Figure B-8. Approval Label 
ATEX Flame-Proof and 
FM Explosion-Proof.

Figure B-9. Approval Label 
ATEX Intrinsic Safety and 
CSA Intrinsic Safety.
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Figure B-10. Approval Label 
FM Intrinsic Safety and 
CSA Intrinsic Safety.

Figure B-11. Approval Label 
ATEX Intrinsic Safety and 
FM Intrinsic Safety.
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APPROVAL DRAWINGS This section contains Factory Mutual installation drawings and Canadian 
Standards installation drawings. You must follow the installation guidelines 
presented in order to maintain certified ratings for installed transmitters. 

This section contains the following drawings:

Saab Rosemount drawing 9150077-944, Issue 1:

System Control Drawing for hazardous location installation of intrinsically safe 
FM approved apparatus.

Saab Rosemount drawing 9150077-945, Issue 1:

System Control Drawing for hazardous location installation of CSA approved 
apparatus.

Saab Rosemount drawing 9150077-991, Issue 1:

IECEx Flameproof System Control Drawing.

System Control Drawing for hazardous location installation of SSA (IECEx) 
approved apparatus.
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Figure B-12. System Control Drawing for hazardous location installation of intrinsically safe FM approved 
apparatus.
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Figure B-13. System Control Drawing for hazardous location installation of CSA approved apparatus.
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Figure B-14. System Control Drawing for hazardous location installation of IECEx approved apparatus.
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